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Chapter 1: Introduction

The MC Pro can be used as a standalone controller, or as an integrated component of a System 5 MC system. 
MC Media Application Controller

The MC Media Application Controller (MC Pro, or “MC”) is a standalone control surface designed to control digital audio 
workstations. 

System 5 MC

The System 5 MC is an audio recording, editing, and mixing system that integrates the MC Pro with System 5 CM408T channel 
strip modules. Multiple CM408T modules, each with eight channel strips, can be integrated to control an unlimited number of 
audio channels simultaneously.

The MC found in the System 5 MC has exactly the same powerful control features found in the standalone version but is also able 
to manage channel strip assignments, layouts, and strip functions. The System 5 MC is fitted with a pair of joystick panners in 
place of the MC’s four faders (joystick panners can also be ordered in the standalone version).

MC Pro
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MC Features
With a myriad of customized controls (keyboard, trackballs, Touchscreen, Soft Keys, faders and knobs), the MC Pro speeds oper-
ation, enhances creativity, and integrates the tasks of mixing and recording. The system also includes Studio Monitor Express 
(SME), a sophisticated monitoring application. SME provides surround monitoring with multiple speaker controls and is selected 
from the MC Touchscreen.

The MC and workstation are connected via Ethernet, sending mouse, keyboard, and EUCON™ commands to the workstation 
computer (Mac or Windows). The MC integrates the control surface with the workstation and allows open connectivity, integra-
tion with third-party plug-ins, virtual instruments, video solutions, and I/O hardware. The MC is modular, expandable, flexible, 
and cost-effective.

Multiple Levels of Control

The MC uses five levels of control:

• Keyboard and trackball

• Programmable key commands via the Soft Keys

• HUI command protocol to control Pro Tools 8.x and lower

• Mackie Control Universal protocol for DAWs/media software that support it (such as RME HDSP Mixer and Sony Vegas)

• EUCON control of EUCON-aware applications (such as Pro Tools® 9 and higher, Nuendo, Logic Pro, and Pyramix)

Level 1: Keyboard and Trackball

The MC accesses your applications using its full-sized keyboard and two trackballs. Each trackball has a control ring and four 
user-programmable switches, allowing both left- and right-handed operation. One or both trackballs can be swapped out for a 
jog/shuttle wheel, and the MC can be set to interpret the physical left and right edit controllers as left or right, depending on your 
needs. For example, in large dual-operator System 5 MC setups with two MCs, the left-side operator can use the right-side MC’s 
left trackball as the right trackball or jog wheel. The trackball rings can also be used for Wheel Edit Mode functions, like zooming, 
trimming, nudging and moving clips. 

Level 2: Soft Keys

The MC uses Soft Keys with integrated LCDs to display switch functions and icons. The Soft Keys can be programmed to send 
complex macros and simple keystroke commands and are named so their function is obvious. Any function can be assigned to 
each Soft Key to suit your working style.

Soft Key mappings are saved to Application Sets (also referred to as AppSets), which automatically change as each application is 
activated. Default Application Sets are supplied for a number of programs but these can be modified and saved. Soft Keys can be 
locked to a specific application, which maintains control even when it is not the workstation’s current application (the term in 
focus is used for the current or front application). The Soft Key displays can show any character set.

Level 3: HUI

MC supports the HUI (Human User Interface) command protocol for control of Pro Tools version 8 and lower. HUI mappings are 
saved with Application Sets for instant recall when each application becomes active.

Level 4: Mackie Control Universal

MC supports the Mackie Control Universal protocol to control DAWs and other software that supports this protocol. Mackie Con-
trol mappings are saved with Application Sets for instant recall when each application becomes active.

Level 5: EUCON High-Speed Control Protocol

EUCON is a control protocol originally developed to communicate between the System 5 control surface and its software appli-
cations. Applications such as Pro Tools 9 and higher that are specifically designed to work with the MC and the EUCON Appli-
cation Programmer Interface are called EUCON-aware applications; all others are called generic. EUCON-aware applications allow 
a higher level of integration than generic applications.
MC Pro User Guide2



The EUCON protocol enables high-speed, bidirectional communication between Avid consoles, the MC, and EUCON-aware soft-
ware applications. The MC and a EUCON-aware application are tightly interwoven so the host application does not see the MC 
as a controller, but as an integrated part of its user interface. Every MC control can intelligently and rapidly access any function 
in a EUCON-aware application.

Avid Pro Tools

Avid Pro Tools 9 or higher supports the EUCON protocol for fully integrated control of Pro Tools software.

Steinberg Nuendo

Nuendo includes EUCON support via an optional Nuendo EUCON module, enabling control from MC, System 5 MC, and System 
5 film post-production and music consoles. The Nuendo EUCON module is sold exclusively through the Avid distribution net-
work and packaged with MC and System 5 MC.

Apple Logic Pro

Logic Pro (as of v.7.2.1) supports the EUCON protocol, enabling full control of all Logic Pro tracks, plug-ins, and other parameters 
through the MC and System 5 MC. EUCON support is built into the application and does not require any special configuration 
or additional software from Apple.

Merging Technologies Pyramix with OASIS and EUCON Support

Pyramix users must purchase Merging Technologies’ OASIS control protocol option, which automatically enables EUCON con-
trol. Oasis is available through Merging’s distribution channel for use with the MC, System 5 MC, and System 5 Hybrid consoles.

Studio Monitor Express Application

The MC includes Studio Monitor Express (SME), a powerful monitoring application that resides on the application workstation. 
SME controls audio routing between applications that support ASIO hardware on the PC, Core Audio applications on the Mac, 
and their respective hardware interfaces. To configure SME, see Chapter 9, “Studio Monitor Express (Windows)” or Chapter 10, 
“Studio Monitor Express (Mac).”
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System Requirements and Compatibility
Avid can only assure compatibility and provide support for hardware and software it has tested and approved. 

For complete system requirements and a list of qualified computers, operating systems, hard drives, and third-party devices, visit:

www.avid.com/compatibility

Registration
Review the enclosed Registration Information Card and follow the instructions on it to quickly register your purchase online. 
By registering, you become eligible to receive the following:

• Technical support information

• Software update and upgrade notices

• Hardware warranty information

About This Guide
This guide provides a basic overview of MC Pro features and functionality.

For complete instructions on connecting and configuring your system, see the MC Pro Installation Guide.

Conventions Used in This Guide

All of our guides use the following conventions to indicate menu choices and key commands:
:

The names of Commands, Options, and Settings that appear on-screen are in a different font.

The names of keys on the control surface are shown in bold (such as SEL).

The following symbols are used to highlight important information:

Convention Action

File > Save Choose Save from the File menu

Control+N Hold down the Control key and press the N key

Control-click Hold down the Control key and click the mouse button

Right-click Click with the right mouse button

User Tips are helpful hints for getting the most from your system.

Important Notices include information that could affect your data or the performance of your system.

Shortcuts show you useful keyboard or mouse shortcuts.

Cross References point to related sections in this guide and other Avid guides.
MC Pro User Guide4



About www.avid.com
The Avid website (www.avid.com) is your best online source for information to help you get the most out of your Pro Tools 
system. The following are just a few of the services and features available. 

Product Registration

Register your purchase online. 

Support and Downloads

Contact Avid Customer Success (technical support); download software updates and the latest online manuals; browse the Com-
patibility documents for system requirements; search the online Knowledge Base or join the worldwide Pro Tools community on 
the User Conference. 

Training and Education

Study on your own using courses available online or find out how you can learn in a classroom setting at a certified Pro Tools 
training center. 

Products and Developers

Learn about Avid products; download demo software or learn about our Development Partners and their plug-ins, applications, 
and hardware. 

News and Events

Get the latest news from Avid or sign up for a Pro Tools demo.
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Chapter 2: Installation and Configuration

This chapter provides in-depth information to configure your MC beyond the basic setup information found in the MC Pro 
Installation Guide. Before proceeding with this section, make sure you have followed the steps in that guide for your single or 
multiple workstation configuration. 

Hardware Installation
This section will help streamline and optimize your MC installation.

System Optimization

Network

The MC, CM408T modules, and your workstations must be on an isolated Ethernet network (minimum 100 Mbit), due to the 
large amount of data transmitted between all components. Network traffic unrelated to audio tasks may cause slowdowns and 
errors. 

If your workstations absolutely require outside network access, an Ethernet DHCP router/switch must be used to separate the MC 
from outside networks. Avid only supports configurations in which the MC and CM408T modules are isolated on their own sep-
arate network.

Workstations

Make sure to keep all workstations up to date by installing the most recent drivers for all hardware. Some older drivers, especially 
for network and audio processing cards, are unable to handle the MC and CM408T data requirements. This can result in sluggish 
behavior that affects channel banking across modules, updating playback status on modules, and other data-intensive functions.

Back Panel Connections
MC back panel

LANLAN DC INTALKBACK MIC

VGA KEYBOARD USB SWITCH HEADPHONES

FOOT

1 2 3 4 5 6 7 8
1  VGA

2  Keyboard

3  USB

4  Talkback Mic Output
5  LAN

6  Footswitch

7  Headphone

8  DC In
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Required Connections

The MC requires Power, network, and USB connections. 
MC Pro User Guide8
DC In Connect the included DC power supply to DC In on the back panel. The supply is world-compatible (accepts 100–240 V, 
50/60 Hz) and draws 150 W maximum.
LAN (RJ-45) Use CAT5 (or better) cable to connect the MC to the router included with your system. (Different routers are used for 
standalone MC setups and multiple-unit installations.) 

USB Connect external storage devices for data backup and software updates. The USB port is also used to connect the supplied 
relay interface for multiple workstation setups.

Attach the power supply to the MC before plugging into AC power or the unit may be damaged.
Other Connections
Talkback Mic Output (XLR) Mic-level output for built-in talkback microphone. The output must be connected to a preamp with 
48V phantom power, to obtain line-level output (phantom power is required because it is a condenser microphone).

Foot Switch (1/4-in Mono) The foot switch mirrors the operation of the Talkback switch on the MC surface. Connect a standard 
two-conductor foot switch (such as a MIDI keyboard damper pedal) to the MC Foot Switch jack to toggle Talkback on/off.

Headphones (1/4-in Stereo) Thru connection to front panel headphone connector.

Service VGA and Keyboard (DB15HD, PS2) VGA video and keyboard connection (for service only).

EUCON Software Installation
The EUCON software installs components that enable bi-directional communication between the MC and the workstation. The 
EUCON-WS version of the software must be installed on every workstation used with the MC. The EUCON-MC version is 
installed on the MC when shipped and can be easily upgraded.

Uninstalling Previous Versions

The old version of the EUCON software must be uninstalled on the workstation before upgrading to the new version. Close all 
applications and follow the procedure for Mac or Windows. 
To uninstall on Mac:
 Open a Finder window, navigate to the Applications folder, and run the EUCON-WS Uninstall program to remove the EUCON 
software from the workstation.

To uninstall on Windows

 Choose Start > All Programs > EUCON, and click Uninstall. The EUCON Uninstaller removes the EUCON software from the 
workstation.

Proceed with installing the new EUCON software. Rebooting the computer before installing the new software is not necessary.



EUCON-WS Software Options (Windows)

The Windows installer offers the following options:

EUCON Workstation Core

This is the main driver that controls communication between the MC and workstation. This option cannot be deselected (it is 
grayed out and inactive), because it must be installed for the workstation to communicate with the MC.

Euphonix Studio Monitor Express (SME)

This software monitoring application interfaces with the MC Monitor section. SME can be configured to receive audio from ap-
plications running on the computer or from external sources via physical inputs to your sound card, enabling extensive audio 
routing, source selection, and level control from the MC. Those who prefer to use Nuendo’s Control Room Monitor (similar to 
SME), may choose not to install SME.

EUCON adapter for Nuendo

This enables EUCON communication between the MC and Nuendo. Nuendo users must install this component. A license to en-
able EUCON within Nuendo (in Nuendo’s Device Setup) is required and must be authorized on your Syncrosoft USB dongle be-
fore you can use Nuendo EUCON with the MC.

VST Plug-in Layouts for Nuendo

This option installs .xml files that map parameters of Nuendo’s VST plug-ins to the MC’s Soft Knobs and to the CM408T’s knobs.

EUCON Adapter for Pyramix

Pyramix users must install this component to enable EUCON control of Pyramix.

Studio Monitor Pro 2 (SMP2)

This PC-based professional monitoring application provides all the functionality of SME with additional multi-channel function-
ality for up to 7.1 monitoring. This application also adds assignable Monitor Inserts and multiple talkback configurations and 
more. This application requires iLok authorization to run.
Windows 7 users should disable User Account Control (UAC). Go to Control Panel > User Accounts > Turn User Account Control 
On or Off 
Windows Vista User Account Control Preference
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Upgrading the EUCON-MC Software

To upgrade the EUCON-MC software on the MC:

1  Download the latest version of the EUCON-MC software from: http://www.avid.com/proseriessupport.
MC Pro User Guide10
2  Copy the installation executable you downloaded onto a removable USB drive.

3  On the MC, touch Euphonix Menu > Shutdown, then touch Exit To Operating System. This quits the MCApp software.

4  On the MC, click Start > Programs > EUCON > Uninstall. The EUCON Uninstaller removes the EUCON-MC software.

The EUCON-MC and the EUCON-WS software must have the same version and build or they may not communicate properly. 
Check the EUCON-WS version installed on your workstations. Download the current version and install it on all workstations 
used with the MC if the version (build) does not match the EUCON-MC software you just downloaded.
5  Restart the MC.

6  Insert the removable USB drive into the MC USB port. The drive appears in My Computer on the MC desktop.

7  Double-click the drive to display its contents.

8  Double-click the EUCON-MC executable file. The installer program launches. Install the software to the default location:

User sets are not deleted during the uninstall procedure. However, updated user sets are installed while upgrading the EUCON 
software. To ensure these are installed in the default location, back up C:\Program Files\Euphonix\EUCON\User Sets to 
removable media, then delete the Usersets folder. The new user sets are not installed if the current ones are not first removed.
(C:\Program Files\Euphonix\EUCON).
The MC presents a list of three options to install:

MCApp, EUCON Runtime, etc. This is the main MC software application. It is grayed out (and cannot be deselected) since it must 
be installed for the MC to function properly.

MC PC104 Driver, Hardware Support, Firmware This installs the actual hardware driver the EUCON-MC uses to control the MC 
surface. 
CM408T Software + Update Server This installs the Firmware Updates server, which updates the CM408T module firmware. 
See “Firmware Update Server (System 5 MC Only)” on page 10.

9  Click Next in the remaining dialogs in the Install Wizard.

10  Reboot the MC when the Wizard finishes.

Firmware Update Server (System 5 MC Only)

If CM408T Software + Update Server is checked, the Firmware Update Server launches after the EUCON-MC installation com-
pletes. The CM408T modules will then prompt to be updated. If they do not, reboot them and they will connect to the Firmware 
Update Server. Press the Y key on each CM408T after the update prompt appears. Each CM408T will apply the update, automat-
ically reboot, and be ready to operate. After all CM408T modules are updated, quit the Update Server.

Do not uncheck this or your MC will not function. 



Configuration

MC Client Software Configuration
General

Installing MC Client is discussed in the MC Pro Installation Guide. Once installed, MC Client does not need further configuration 
for applications. It automatically detects if an application is EUCON-aware and enables EUCON communication. If an applica-
tion is not EUCON-aware, it enables the MC keyboard, trackball, and Soft Keys to control your application as if the MC were a 
peripheral directly plugged into your workstation. Since MC Client runs at the operating system level, it can control all non-EU-
CON-aware applications just as your regular keyboard/mouse combo can (with the useful addition of Soft Key macros).

Configuring HUI/Mackie Control Protocol

Since HUI and Mackie Control Universal use MIDI to communicate, they require allocation of MIDI ports by the operating 
system. The EUCON software creates a virtual MIDI driver with up to 32 ports, but actual communication with the MC occurs 
over the faster and more reliable Ethernet network. HUI and Mackie Control use up to four MIDI ports per application. Ports are 
allocated by the user using the EuPrefs (OSX) or the Euphonix Control Panel (Win).

Mac

To configure applications with HUI/Mackie control in OSX: 

1  Drag your desired applications into the EUCON Preferences pane (Apple Menu > System Preferences > EUCON Preferences). 
2  Select the Protocol and MIDI ports to be used.

Windows

To configure applications to be used with HUI/Mackie Control on Windows: 

1  Open the EUCON Control Panel (Start > Control Panel > EUCON). 

2  Click the ADD button and browse to the desired application. 

3  Select the Protocol and MIDI ports to be used. 

EUCON Preferences pane
Chapter 2: Installation and Configuration 11



4  Click Apply when you are done.
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This configuration is only necessary with HUI and Mackie Control applications. EUCON-aware applications communicate auto-
matically with the MC. MC Client enables the MC’s keyboard, trackball, and Soft Keys to control all non-EUCON-aware applica-
tions just as the keyboard and mouse.

MC Client and EUCON Discovery Options

On Mac, MC Client launches on startup and runs invisibly if the EuPrefsPane is active. 

Euphonix Control Panel
To enable or disable MC Client and EUCON activity: 
 Open the EuPrefsPane and click the Start/Stop button at the bottom of the window. EUCON defaults to active when installed.

When Windows loads, MC Client and EUCON Discovery services automatically start, and their icons appear in the system tray. 
In Windows, Right-click the EUCONDiscovery icon in the system tray for these options:

EUCON Network

This lists each installed network card with valid TCP/IP connection. Select the network on which the MC and your workstation 
will communicate from this list.

Enable Discovery Network Wide Logging Toggle this setting on for debugging only.

Display Discovery Database Opens a list of all EUCON clients on the network.
Quit Shuts down the MC Client service.
IP Addressing

MC

The Netgear RP614 router (or other) included with the standalone MC takes care of all IP addressing, using its internal DHCP 
server to distribute IP addresses to the MC and your workstations. Make sure the router is powered on and connected (with Ether-
net cables) to your MC and workstations for the DHCP server to correctly assign IP addresses.

The WAN port on the Netgear can be connected to a studio LAN, or to an Internet connection, depending on your studio setup. 
Note that the MC and workstations must be on the same network subnet for the MC to connect to your workstations properly 
(connecting them all to the LAN ports on the Netgear automatically does this).



System 5 MC

The CM408T modules do not allow static IP addressing. Use a DHCP server to auto-assign their IP addresses. The SonicWALL PRO 
1260 router (or other) included in the System 5 MC system is set to perform this function by default.

To set up the System 5 MC network, connect the MC and CM408T modules to the SonicWALL 1260. (or other router included 
with your configuration). The SonicWALL 1260 auto-assigns their IP addresses. The MC can now recognize the CM408T modules. 
See “Modules” on page 16 to configure the MC to control the CM408T modules.

The SonicWALL 1260 (or other) included router is shipped with all default settings unchanged. To log into the SonicWALL: User-
name: admin Password: euphonix. The SonicWALL 1260 checks for a DHCP server on the LAN to which it is attached. If a DHCP 
server is not found, it enables its own internal DHCP server.

To access the SonicWALL web configuration interface:

1  Connect a workstation to one of the 1260 LAN ports.

2  Set the workstation to obtain an IP address automatically using DHCP.

3  Open a web browser and type 192.168.168.168 (the router’s default IP address) into the location address field.

4  Log in to the SonicWALL: Username: admin Password: euphonix The SonicWALL Setup Wizard then launches to configure the 
router settings.

Refer to the SonicWALL 1260 manual (included with your System 5 MC or available at SonicWALL’s website) for more informa-
tion on router settings. Consult your network administrator to find appropriate settings for your LAN.

Workstation Control
The MC can control up to four workstations using the Workstation keys.

To assign Workstations:

1  Press the Strip Control Setup key on the right side of the MC. 

Workstation keys

Workstation

21

3 4
Strip Control Setup key

Strip Control

Setup

Flip

Home MC

Nudge Nudge

Bank Bank

Setup

Strip Control

Flip

Home MC

Nudge Nudge

Bank Bank

Layouts
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The Touchscreen opens and displays all workstations available on the network. Each workstation must have MC Client running 
to be available to the MC.
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2  Touch a Workstation Key on the left of the Touchscreen.

3  Touch the Workstation name in the list to assign it to the selected number.

4  To disconnect the MC from its current workstation, touch the Workstation key mapped to that workstation, then touch 
None/Disconnect. The assignment is relinquished and the MC disconnects from the workstation.

5  To view all Workstations, use the up/down arrows to scroll.

6  Repeat Steps 2 and 3 to assign additional Workstations.

7  Press the Strip Control Setup key again to exit Workstation assignment mode.

8  Press one of the Workstations keys to connect to that Workstation.

Workstation Binding

Workstation Binding is a feature that retains workstation assignments made in the Workstations Setup Touchscreen. If you reboot 
your workstation while connected to the MC, subsequently pressing the assigned Workstation button reconnects without having 
to re-assign the workstation. Pressing the previously assigned Workstation button on the MC reconnects to this workstation with-
out needing to reassign. Allow time for MC Client to load as it usually takes about 15 seconds after the computer boots to the 
Desktop. 

Workstation Touchscreen



The MC Client icon is visible in the Windows Taskbar when MC Client is launched. There is no equivalent indication on the Mac. 
However, if you use SME and have it set to auto-launch (in System Preferences, EUCON Preferences Pane) on this Mac, MC Client 
completes loading shortly after the SME interface becomes visible. This is particularly useful if you generally use the MC with the 
same workstation assignment.
If the MC reboots while connected to a workstation, MCApp relaunches, then the MC re-connects to the previously assigned 
workstation without needing to press the Workstation button.

Visit Workstation

A workstation may be visited by pressing Shift+Workstation 1–4 key. Visiting is a quick way to deliver keyboard and trackball 
commands to the visited Workstation without actually switching EUCON-aware workstations. For example, while working in 
Nuendo, you can quickly switch to a Pro Tools workstation to dismiss an on-screen dialog or do a quick edit.

Visiting also causes the (optional) Ontrak USB to GPI (for DVI switching) to switch to the selected Workstation number.

Workstation Binding

User
Assigns

MC to WS

WS is 
rebooted

MC is
rebooted

WS 
becomes 
available

Pressing WS 
button 

connects MC 
to WS

Pressing WS 
button 

connects MC 
to WS

MC
auto-

connects
to WS

MC retains 
WS 

assigment

WS 
available

WS Not 
available

Press WS 
button, MC 
connects to 

WS

WS 
assignment
retained by 

MC - 
Pressing WS 

button 
attaches MC 

to WS

WS 
becomes 
available
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Modules 
(System 5 MC Only)
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This Touchscreen assigns CM408T modules to the MC. All available CM408Ts are listed on the right under All Online. Currently 
assigned CM408Ts are listed on the left under Assigned to this MC. This is the order in which the MC assigns channel strips to 
the modules.

• To assign a module to the MC, touch it in All Online and touch the Add button.The new CM408T appears under Assigned 
to this MC.

• To deassign a CM408T from the MC, touch the module in the Assigned to this MC list and touch the Remove button.

• To change the order of CM408Ts in the Assigned to this MC list, touch the module and touch the Move Up or Move Down 
buttons.

• After adding, removing, or moving modules, you must touch the Update Modules button (flashes when changes have oc-
curred) to apply the settings.

• To display the name, MAC address, IP address, and software version of a CM408T module, touch it in the Assigned to this 
MC list and touch the Show Info button. The information appears on that CM408T’s LCD display.

• To name a module, touch it, touch the Edit Name button, and type a name.

Preferences-Modules Touchscreen



Chapter 3: Main Touchscreens

This chapter introduces the MC Touchscreen interface and the main Touchscreens used for normal workflow. The Touchscreen 
allows you to touch screen items that you would normally click with a mouse. The main difference between a touch and con-
ventional interface is that there is no double-touch corresponding to a double-click to launch or open an item. We use the word 
touch (instead of click, select, or press) to activate, select, or open items in a Touchscreen. To select an item from a menu, we use 
the following convention:

 Touch Menu > File means touch the Wave icon and select File from the Menu.

When the MC starts, the default Touchscreen is Main-Tracks. This is the Main Touchscreen with the Tracks tab selected. The Main 
Touchscreen also has a Flip page.

Main-Tracks
When connected to a EUCON application, this Touchscreen displays the tracks. If the project has more than 48 tracks, use the 
scroll bar at the right or the arrow buttons below it to display additional tracks.

Main-Tracks Touchscreen

Wave menu
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The top-left of the screen displays the following information (top to bottom):

• Application to which the MC is currently connected

• Name of the workstation to which the MC is connected

• Current User Set

• Currently focused channel in yellow text

SMPTE time, minutes/seconds, feet/frames, and bar/beat counters are located to the right of that display.

On the top-right, the Touchscreen displays either the four tracks currently assigned to the four faders, or two tracks currently 
assigned to the pair of MC joysticks.

The left of the Touchscreen displays five mode buttons that apply functions to selected tracks:

Solo Select tracks to solo. (For information on Solo modes, see“Solo” on page 22.)

Arm Arm tracks for recording.

Mute Turn tracks on/off.

Select Select a track on the MC and in the DAW.

Wave Focus a track to the Soft Knobs.

To apply a function:

 Touch its button and then touch tracks in the grid to apply the function. Touch selected tracks again to toggle that function off.

Use the Clear button beside each function to release all tracks from that function. For example, touch the Clear button next to 
Solo to unsolo all soloed tracks.

The channel squares in the track grid show status in several ways:

• Whitish-blue background coloring with yellow text means the channel is selected

• Blue-gray background coloring represents muted tracks.

• A red border around the square means the track is soloed.

• A red dot at the top right of the square means the track is armed for recording

• Colored bars below the text are DAW track colorings in DAWs that offer it.
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Main-Flip (System 5 MC Only)
A row of the CM408T module’s knobs can be flipped onto its faders. The parameters on the row of knobs appear on the faders 
and the parameters on the faders appear on the row of knobs. Flip works across the entire console surface.

The Main-Flip Touchscreen shows eight buttons corresponding to the CM408T’s eight rows of knobs.

• Touch a number once to flip that row. The button stays lit while the row is flipped.

• Touch a highlighted number to flip it back to normal. The button extinguishes to show the row is no longer flipped.

The Flip buttons intercancel: touch a new Flip button while a row is flipped to cancel the first flip and flip the new row.

Wave Menu

Main-Flip Touchscreen
Touch the Wave Menu icon to display a popup menu with four options pertaining to configuration and file operations: File, 
Shutdown, Prefs, and Setup.

Wave Menu Icon
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M and K Indicators

The M and K indicators correspond to mouse and keyboard, respectively, and show whether the MC trackball and keyboard 
control the MC (local) or the workstation (remote):
Table 4. 
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On the MC keyboard, press Alt+Backslash to toggle this control.

File

Touch Menu > File to display the File Touchscreen. User Sets and App Sets tabs allow typical File operations on User Sets and 
Application Sets, respectively. For more information, see “User and Application Sets” on page 69.

Shutdown

Color Mouse and Keyboard Control

Orange MC

Gray Workstation
Touching Menu > Shutdown is the only proper way to exit MCApp and has these options:

Shutdown Exits MC and operating system.

Restart Restarts MC and operating system.

Exit to Operating System Exits to Windows operating system.

Shutdown Touchscreen



Chapter 4: MC Preference Settings

This chapter describes the Preference settings in the Euphonix menu that change how the MC operates.

General

Selected options are colored cyan and deselected options are royal blue.
This Touchscreen controls six global preferences, each of which may be selected independently:

Workstation tracks knobset changes Makes Workstation aware of which knobset is selected and displays appropriate controls.

Open plug-ins on workstation when editing Supports opening plug-in windows from the surface.

Close plug-ins on workstation when finished editing Closes plug-in window when leaving Knob set.

Attention most recently selected track Changes the Soft Knobs to control the knobset of the most recently selected track. In 
effect, this links the Wave key to the Channel Select key.

Select most recently attentioned track Selects the track with the knobset most recently assigned to the Soft Knobs. In effect, this 
links the Channel Select key to the Wave key.

Select channel by touching fader/joystick Touching a fader assigned to a specific channel on the MC, CM408T module (System 5 
MC only), or joystick panner, selects that channel in the DAW.

Preferences-General Touchscreen
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Wrap-Around Banking 
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Touch the Wrap-Around Banking button to toggle wrap-around banking on/off. When enabled, the Bank and Nudge buttons 
continuously bank through the tracks available, moving from the last track to the first. When disabled, the banking stops at the 
highest track (with the Bank Right button) and the lowest track (with the Bank Left button). This applies to standalone MC (with 
a four-fader bank) and System 5 MCs (with CM408T channel strips).

Solo
This Touchscreen controls two solo functions: Solo Mode and Solo Switch.

Preferences-Solo Touchscreen
Solo Mode
Solo Mode has three settings:

Solo In Place Mutes all tracks except solo track.

AFL Solo level derived after fader level.

PFL Solo level derived before fader level.
Solo Switch
In both of the following Solo Switch settings, pressing an active Solo key deactivates that key:

Intercancel Each usage of the Solo switch solos that channel and deactivates the previous selection.

Sum Each usage of the Solo switch solos that channel and leaves other soloed channels active.

Solo Mode and Solo Switch settings are currently only supported by Nuendo.



Setup
Touching Euphonix Menu > Preferences > Setup opens the most recently used Setup Touchscreen.

Devices

This setting lets you swap the mapping of the track wheels (jog rings around the trackball), enabling the physical left jog wheel 
to be used as the logical right wheel. This is useful for left-handed users and to allow two users access to the track wheels with one 
person sitting to the left of the MC but operating the right (logical) track wheel.

To reassign either wheel:

1  Touch Identify Left Wheel or Identify Right Wheel. The MC displays a dialog requesting movement of the track wheel to remap.

2  Move the desired track wheel and touch OK.

The MC now interprets all commands coming from that track wheel as coming from the Right or Left Wheel you selected.

Jogwheel Speed

The Jogwheel Speed adjusts the responsiveness of the Jogwheel. A setting of 10 (default) is 100%, or full speed. A setting of 1 is 
10%, or slow response.

Preferences-Setup

The Surface Filter buttons and controls are for factory use only. Do not modify these settings unless instructed to do so by an Avid 
representative.
We recommend a setting of 1–3 for Logic Pro.
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Surface Filter Update Period

This setting modifies the interval at which the MC sends automation data back and forth to your workstation(s). The range is 
5–250 ms and the default is 42 ms. You will not need to modify this setting unless your project has extensive automation, in 
which case you may need to increase it. Be careful because setting it too low (rate too high) may deliver incorrect automation.

Set MC Name

The Touchscreen also displays the name of the MC (default is Euphonix MC), and allows changing it. The MC Name is used to 
distinguish between surfaces in multiple-MC configurations. 

To change the name: 

1  Touch Set MC Name. 

2  Type the desired name. 

3  Touch OK.

Fader Text Mode and Knob Text Mode

These settings control how fader and knobset scribble strips on the CM408T modules behave when displaying text.

Momentary Value Displays values as they are changed, then reverts to the name after a fixed time interval.

Always Show Names The name of the control is always displayed.

Always Show Values The value of the parameter is always displayed.

The value for fader strips is always the channel level in dB. The knobset value changes depending on what is assigned to the 
knobset (such as EQ, dynamics, or plug-in controls).

Soft Key Display and Operation

This setting controls the text brightness/contrast of the integrated LCDs in the Soft Keys, and the timing of button latching, re-
peat delay, and repeat rate. To set the brightness of the Soft Keys, use the arrow keys to increase/decrease the illumination (1–10):

Blue Brightness Sets the illumination for the blue Soft Keys.

Green/Orange/Red Brightness Sets the illumination for the Green/Orange/Red Soft Keys.

Contrast Changes the contrast on all soft keys.

Dim Level Sets the illumination for dimmed Soft Keys.

To set the button timing of the Soft Keys, use the arrow keys to increase/decrease the time:

Latch Timeout Sets the amount of time (50–500 ms) before a held-down button becomes momentary or non-latching. For exam-
ple, a Solo button held down longer than the Latch Timeout setting becomes non-latching and turns off when released. Buttons 
held down for a shorter time than this setting behave normally and turn on or off depending on their prior state.

Repeat Delay Sets the amount of time (250–1000 ms) before a repeatable button starts repeating its command when held down 
(such as Nudge or Zoom).

Repeat Rate Sets the amount of time (30–400 ms) between the repeated commands when a repeatable button is held down. The 
button begins repeating after being held down for the Repeat Delay setting.
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Network
The Network pane in the MC preferences section lets you customize the addressing used for multicasting data used by the 
EUCON system.

Although most systems will never need to use this feature, special care should be taken if it is determined that custom network 
settings are to be used. Please consult with your IT department to ensure proper addressing and port settings are used for your 
place of operation. 

To set custom multicasting settings:

1  Connect to all the workstations and modules you want to change settings for. Be aware of the following: 

• Only workstations assigned to the four workstation switches will be affected by this change.

• Only CM408T modules “Assigned to this MC” will be affected by this change

2  Go to Menu > Prefs > Network tab.

3  Touch the Use Custom Settings button (off by default).

4  Make changes to your settings. 

Generally, you will want to choose an address from the following ranges based on direction from your IT department (which they 
are responsible for allocating per subnet and site).  (Information taken from Stevens, Section 21.2 (pg 553).

5  Go to the Setup > Modules page on the MC and “remove” all the attached CM408T modules.

6  Restart all CM408T modules by pressing the RESET button located on the bottom front of the units.

7  Restart the MC by doing the following: 

Network

Link-local  224.0.0.0    to    224.0.0.255

Site-local 239.255.0.0    to    239.255.255.255
• Go to Euphonix Menu > Shutdown.

• Touch Restart.
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8  Log out of all your workstations and log back in. Note the following:

• You may need a separate keyboard and mouse to do this since EUCON connectivity will not be established at this point.

• When you log out, all EUCON-based processes are shut down and relaunched again when you log in. This ensures that the 
new custom network settings are applied to the workstation.

• Alternatively, you may restart your workstations, although it should not be necessary.

9  Re-attach all your workstations and CM408T modules.

To set the system back to default multicasting settings:

1  Connect to all the workstations and modules whose settings you want to change.

2  Only workstations assigned to the four workstation switches will be affected by this change. Only CM408T modules “Assigned 
to this MC” will be affected by this change.

3  Go to Euphonix menu > Prefs > Network tab.

4  Deselect the Use Custom Settings button.

The default factory multicast settings should now appear in the fields below in DIM lettering.
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5  Go to the Setup > Modules page on the MC and “remove” all the attached CM408T modules.

6  Restart all CM408T modules by pressing the RESET button located on the bottom front of the units.

7  Restart the MC.

8  Go to Euphonix Menu > Shutdown.

9  Press Restart.

10  Log out of all your workstations and log back in. Note the following: 

• You may need a separate keyboard and mouse to do this since EUCON connectivity will not be established at this point.

• When you log out, all EUCON-based processes are shutdown and relaunched again when you log in. This ensures that the 
network settings are applied to the workstation.

• Alternatively, you may restart your workstations, although it should not be necessary.

11  Re-attach all your workstations and CM408T modules.

Base: 224.1.239.0

Mask: 255.255.255.0

Discovery: 224.1.239.2 Port: 4242

EuCon 224.1.239.42 Port: 4245

Logging: 224.1.239.3 Port: 4243



About
This Touchscreen displays the version of the EUCON software loaded on the MC. The EUCON-MC software can be upgraded by 
downloading the latest version from our website. Contact Avid support for more information (available through our website: 
www.avid.com). 

Preferences-About Touchscreen
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Chapter 5: Soft Keys
Banks
Soft Key banks are saved snapshots of all Soft Key commands for a specific MC Soft Key section. There are three Soft Key sections, 
each with individual banks: the Soft Keys section (24 Soft Keys to the left of the Touchscreen), and the Left and Right Edit sec-
tions. The main Soft Keys section has six dedicated bank buttons at the top, and the two Edit sections each have four bank but-
tons. However, using the Soft Key Bank Jump commands, an unlimited number of banks can be created, stored, and recalled. Ad-
ditionally, a Soft Key in any section can recall banks to both its own section and the other two Soft Key sections.

A Soft Key can store a sequence of commands (enabling complicated sequences to be carried out with one keystroke). Soft Keys 
can transmit four command types:

• EUCON: for in-depth control of EUCON applications (one per Soft Key)

• Key: keystroke sequences to control any application (unlimited per Soft Key)

• Bank: switch banks on one or more of the MC Soft Key sections

• MC: MC-specific commands

The Bank keys display banks 1–6.

Soft Keys
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Soft Keys Setup
Press the main Soft Keys Setup button (bottom-right of the Soft Keys section) to configure the main Soft Keys. The Right/Left Edit 
section Soft Keys can be changed by pressing that section’s Setup button. The Touchscreen changes to show the Soft Keys setup.

The Commands and Labels tabs of the Soft Keys Setup Touchscreen edit the definitions and labels of the Soft Keys. Press the Soft 
Key to modify; it begins flashing. The Commands and Labels tabs display the Soft Key’s currently assigned commands and labels, 
which can now be modified.

Commands

Four types of commands can be mapped to a Soft Key:

Key Macro commands made up of computer keyboard (ASCII) characters. 

EUCON Mapped from MC directly into application using EUCON.

Soft Key Bank Switch Enable navigation to MC Soft Key banks.

MC MC specific commands are Layout Recall, Parameter Collect, Parameter Punch, Read/Write All and Pause.
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Each Soft Key can contain one EUCON command and unlimited bank switch and key commands chained together in the Soft 
Key definition. The one EUCON command can be assigned in any slot. The commands assigned to the selected Soft Key are listed 
by type in the three slots to the left of the Add button. Touch the arrow buttons to the right of the three slots to move back and 
forth through the assigned commands. When the Soft Key is pressed, these commands are executed sequentially from left to 
right.

MC commands



To assign a command, touch the Add button. A pop-up menu requests a choice between adding a Key, EUCON, Soft Bank Key 
Switch, or MC command. Touch to select the command type and the screen for that command is displayed.

The Repeat button (next to the Add button) sets the Soft Key to be repeatable: When the key is held down, the MC repeats the Soft 
Key’s command chain. This is typically used for zoom and nudge buttons. The repeat rate for the command chain is set in the 
Preferences-Soft Keys Touchscreen.

To delete a command, touch the command’s slot in the chain and touch the Delete button. If a command in the middle of the 
chain is deleted, the remaining commands shift left to take its place.

Setup-Commands Touchscreen
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This Touchscreen allows choosing from hierarchical EUCON command menus (the actual contents depend on the EUCON ap-
plication). To assign a command, touch a category in the left-most menu, and use the submenus to find the desired command. 
Touching the command instantly assigns it to the command definition and the Soft Key displays the default command label.

If there are more than three menu levels, they move to the left as the submenus open. To get back up to the top of the hierarchy, 
use the left arrow button below the left-most menu.

Setup-EuCon Commands Touchscreen



This Touchscreen allows typing a command string that is executed by the MC when the specified Soft Key is pressed. Touch any 
of the modifier buttons (Control, Shift, Alt/Opt, Win/Cmd) to include them as part of the Soft Key definition. Multiple modifiers 
can be toggled to create complex application shortcuts. For example, to create the command shortcut Ctrl+Alt+Shift+Z, toggle the 
Ctrl, Alt, and Shift modifiers and type Z into the command box.

Touch Insert Special to open a popup menu of non-alphanumeric keyboard characters and commands (such as Home, End, Page 
Up, Page Down, Delete, or Backspace). The command string for those functions is inserted into the command box at the cursor 
location.

Assigning a Key Command function to a Soft Key does not automatically generate its label. See “Label” on page 36 to assign an 
appropriate label to the Soft Key.

Setup-Key Commands Touchscreen
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This Touchscreen sets a Soft Key to jump to a specific Soft Key bank and determines which MC Soft Key sections are affected by 
that bank switch.

Touch the Action button to change the bank switch action. A pop-up menu selects the next, previous, or another bank. The cur-
rent bank is shown to the left above the image of the Soft Key being edited.

When the Action button is set to Jump To Bank, enter the desired bank number in the command box below the Action button.

Touch the Section button to choose which section should switch banks. A popup menu chooses between the Left Edit, Right Edit, 
or Soft Key sections. This functionality allows the Soft Key command to change only one of the MC Soft Key sections to another 
bank (such as the Right Edit changes from Transport to Edit controls) while having no effect on the other Soft Key sections.

Assigning a Bank Jump function to Soft Key does not automatically generate its label. See “Label” on page 36 to assign an appro-
priate label to the Soft Key.

Setup-Bank Switch Commands Touchscreen



Menu Implementation

Allowing a Soft Key to Jump that Soft Key section to another bank provides several interesting ways to organize Soft Keys. For ex-
ample, a bank can be created that shows the application’s pull-down menus (such as File, View, Insert, or Format) on the top row.
The Nuendo and Pyramix Application Sets use this functionality to put the most important functions on Banks 1–6, with Soft 
Keys that jump to other banks to display further options (such as the File Menu or the Transport commands).

When implementing this functionality, we recommend creating a Soft Key that jumps back to one of the top level banks (such 
as the Home key at the bottom-right of every bank in the Nuendo Application Set). Pressing the Bank 1–6 buttons at the top of 
the Soft Keys also navigates back to Banks 1–6.

Pause
Pause Command
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The Pause command can be used to create a delay in milliseconds in the chain of commands within a Soft Key. The range is lim-
ited to 500 ms per Pause command. Multiple Pause commands can be chained together to create longer delays.

This is especially handy when you create a macro that opens a windows within the host application. A Pause command can be 
inserted to delay triggering the rest of the commands while the window opens. Experimentation is key to finding the best values 
to use on a case-by-case basis. 

Label
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The Setup-Label Touchscreen allows customizing the appearance of the Soft Keys, including color, font, and size. An icon can be 
selected from the Icon list. Touch the Layout button to choose from the popup menu between the following button appearances:

• text only

• text above icon

• text below icon

• icon only

Touch the Font and Color fields to select the desired entries from their respective popup menus. Only Soft Keys in the Left and 
Right Edit sections along the top can be colorized. All other Soft Keys are blue only. Touch the text box to enable editing. The box 
becomes selected, and the text for the button can be edited using the keyboard.

Setup-Label Touchscreen

When scrolling lists of commands and icons, press and hold Shift while pressing Up/Down buttons on the Touchscreen to scroll 
by page. Press and hold Ctrl+Shift while pressing Up/Down buttons the Touchscreen to scroll to the bottom/top of the list.



Cut, Copy & Paste Soft Keys

It is possible to Cut, Copy and Paste Soft Keys when editing an application set using the MC keyboard. 
To cut, copy or paste Soft Keys: 
1  Press the section Setup button and select the Soft Key you wish to cut, copy or paste to. 

2  Use the following keyboard commands to perform the desired function:

• Cut: Ctrl+Shift+X

• Copy: Ctrl+Shift+C

• Paste: Ctrl+Shift+V

Locking

The Locking tab allows locking any or all of the Soft Key sections to a EUCON application, retaining their commands while the 
MC is switched to another application or workstation. The channel strips (or joystick panners) can also be locked in this manner. 
This functionality is used to retain control of one application or DAW while using another. For example:

• Locking the Left Edit section to the Nuendo transport controls while working in Pyramix.

• Using one DAW for playback and another for editing/recording so there is no need to switch back and forth between work-
stations in order to control both DAWs.

• Controlling different applications on the same workstation, such as Pro Tools with the Left Edit section and Logic Pro with 
the Right Edit section, all while editing video in Final Cut Pro.
Setup-Locking tab Touchscreen
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To lock a section:

1  Bring into focus the application to which you intend to lock a section. The application is listed at the top-left corner of the MC 
touchscreen.

2  Press the Setup button of the MC section (Left Edit, Soft Key, or Right Edit) being locked.

3  Press the Strip Control Setup button to select the faders/joystick panners to lock.

4  Touch the Lock Section button to lock the section to the application on the MC’s current workstation.

The selected section is shown at the top-left of the Locking tab Touchscreen. If that section is currently locked, the top button 
of the Locking tab changes from Lock Section to Unlock Section with a red lock icon to its left. The application and workstation 
to which the section is locked are listed to the right of the button.

A locked Soft Key section retains its currently assigned commands until it is unlocked or its individual App Set sections are un-
locked.

The fader/joystick section retains its channel control when locked.

The Monitor and Control Room sections continue to monitor the outputs/application they were locked to.

Press the Unlock All Appset Sections button (appears only when one or more Soft Key sections are locked) to unlock all currently 
locked Soft Key sections, without unlocking the fader/joystick, monitors, or control room sections.

Press Unlock All Sections to unlock all currently locked sections.

To quickly lock a section to an application, put the application in focus, hold down the Shift key on the MC keyboard, and press 
Setup to lock. To unlock, repeat this step.

If any Soft Key section is locked, the Application Set cannot be edited and Soft Key definitions cannot be changed. All Soft Key 
(App Set) sections must be unlocked before changing Soft Key definitions.
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Superlock

Superlock locks the entire MC and CM408T modules (for S5-MC owners) to one application, except for the Monitor and Control 
Room sections, which always lock independently of all other sections. This is useful when switching to another application, with-
out having the MC or System 5 MC constantly switching application sets. For example, you may switch to a database application 
to look up samples, but want to lock the MC to your DAW application.

To engage Superlock, focus to the application you wish to lock to, hold down Ctrl + Shift on the MC keyboard, and press any sec-
tion Setup button (except the Monitor and Control Room Setup buttons). The entire MC and CM408T modules, except Monitor 
and Control Room, are now locked to that application.

To disengage Superlock, press Ctrl+Shift plus a Setup button again, or press a Setup button (showing the locking tab) and touch 
the Unlock All Sections button on the Touchscreen.
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Chapter 6: Soft Knobs

The MC has nine touch-sensitive knobs with LED display rings to control many parameters. These knobs are more effective when 
used with EUCON-aware applications in which they can intelligently access functions (such as EQ, dynamics, aux sends, or 
plug-ins). They can also send out HUI data.

Left and right keys are available to page within a knobset. The eight knobs operate on one channel/track within the selected 
knobset. On the MC, the Soft Key LCD displays show the knob function and when touched, the knob value. Switches are 
available for automation and other knob-related functions.

The Assignable Knob (the bottom-left knob in the Soft Knobs section) can be dynamically assigned to most knob or switch func-
tions in Nuendo and Logic Pro. For example, moving the pointer over a track panner in Nuendo assigns pan to the MC Assignable 
Knob. With Logic Pro, clicking on a track panner assigns that function to the MC Assignable Knob. The Assignable Knob can be 
locked to a particular function by pressing the Assignable Knob’s top.
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Knob Cells
The Soft Knobs area is like a super channel or track inspector to edit a single track. A channel can be attentioned to the Soft Knobs 
area for editing, which is different from selecting it. A DAW can select more than one track at once. Attentioning (sometimes 
called focusing) is meaningful only for the control surface and is done one track at a time.
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The MC’s bank of Soft Knobs contains eight knob cells, each with a:

• Touch-sensitive knob: controls the parameter shown in the Soft Key’s LCD

• Knob top button (knob press): moves one menu level down the hierarchy

• Soft Key: Displays the current parameter assigned to that knob. Pressing the Soft Key moves one menu level down the hier-
archy (same as Knob top button).

• Select key: depends on specific knob function

• On key: activates/deactivates that parameter

• Lock LED: not currently used

• RW LEDs for On key: not yet implemented

• R and W LEDs: displays automation state of currently selected channel

• G LED: not yet implemented

• Back key: moves one menu hierarchy up. Not lit if already at top of the menu structure

In addition, the top of the module has:

• Page Left and Right keys: access additional Soft Knobs pages in the knobset

• Left and Right selector keys: not yet implemented

• Back key: moves one menu hierarchy up

Knob cell controls in Soft Knobs area



Knobsets

Each DAW channel function (such as Aux Send, Inserts, EQ, or Pan) has a knobset associated with it, and the EuCon software in-
cludes knobsets for all supported plug-ins. A knobset is comprised of pages of eight parameters each. The MC and CM408T’s 
knobsets are identical.

Touch-sensitive Knobs

The knobs are touch-sensitive so the system can detect when the knob is touched, moved, and released. Touching a knob displays 
the current parameter’s value on the Soft Key’s LCD instead of the parameter name. Releasing a knob reverts the display back to 
the parameter name.

Assignable Knob
The Assignable Knob can control most knob or switch parameter values in Nuendo or Logic Pro. In Nuendo, move the cursor over 
a parameter on the host screen to assign it to the Assignable Knob. Repeat these functions to assign to other parameters in these 
DAWs.
Press the knob top to lock the current parameter onto the Assignable Knob and light the Lock LED. The cursor can now be moved 
to control other DAW parameters while the Assignable Knob remains in control of the locked parameter. Press the knob top again 
to unlock the parameter, which frees up the Assignable Knob to control another parameter. 

Assignable Knobs

On

R GW

Assignable Knob

R W

Lock

R W

Lock

Ch 12
Aux01

Hall

On

R GW

Assignable Knob

R W

Lock

R W

Lock

Ch 12
Aux01

Hall
Changing Knobsets
If the Workstation Tracks Knobset Changes prefere4nce is set (Preferences > General Touchscreen), the DAW is notified whenever 
a knobset is selected on the MC or a CM408T module. This allows the DAW to show the function of the host screen. When en-
tering a plug-in window, the DAW will open that plug-in window if the Open Plug-ins on entering workstation when editing prefer-
ence is selected and close it upon leaving the Insert knobset if the close plug-ins on workstation when editing is selected. 

Pyramix does not current support the Assignable Knob. Apple Logic Pro users must first click the parameter to control, 
then the Assignable Knob will function as described.
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Chapter 7: Working with Channels

Channel Strips
The MC has four channel strips to which workstation tracks can be assigned. The track names assigned to these strips are dis-
played in the top-right corner of the Main-Tracks touchscreen. Workstation tracks can be assigned to the strips using the Channel 
Select and Wave strip keys, or using the Layouts-Assign Touchscreen. The System 5 MC has two motorized joystick panners in 
place of the four faders.
Solo

When activated, this button solos the assigned channel. Solo preferences are set on the Preferences-Solo Touchscreen.

On

The On key must be lit (active) to hear the channel. The channel is muted when its On button is unlit.

Record

Press the Record key to enable (arm) a track for recording.

Channel Strips Section
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Chan Select Key

Press the Chan Select key to select the channel assigned to that strip. When lit, this channel is selected in the DAW for editing. 
Press the Chan Select key to select a workstation track; it lights when a track is selected. The workstation’s tracks or mixer window 
scrolls to show the most recently selected track.

Select Key

When pressed by itself, the Select key toggles automation Write mode on/off for the track.

LEDs

The green R and red W LEDs are used to denote the automation modes shown in the table, below. 

To set the automation mode: 

 Press and hold the Wave key and press the Select key to select from the popup menu. In Write mode, the red W LED blinks 
when writing automation and is solid otherwise.

Automation Modes
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In Write mode, the red LED blinks when writing automation, and lights solid when the transport is stopped.

Mode R LED (green) W LED (red)

Isolate off off

Read on off

Write off on

Read + Write on on
Wave Key

Press the Wave key to focus a track to the MC Soft Knobs for channel editing. If Select most recently attentioned track is selected 
in the Preferences-General Touchscreen, this will also select the track in the DAW. The Wave key stays lit to indicate it is the 
attentioned channel.

Wave + Select

Press the Wave and Select keys simultaneously to display the DAW automation mode on the MC Touchscreen for that track.

Wave + Chan Select

Press the Wave and Chan Select keys simultaneously to assign a track to a strip. This technique is called Direct Assignment.

Fader

When a workstation channel is assigned to a strip, the fader controls the workstation track’s fader.

The yellow G LED is reserved for future use.



Joysticks
Two options are available for the upper-right area of the MC. The standalone MC is usually fitted with four faders. The System 5 
MC includes a pair of joysticks. 

The Joysticks can send stereo or surround panning to EUCON-aware applications. The MC Joysticks section has similar functions 
as the fader.

Joystick Touchscreen
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Strip Control Section
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MC Key (System 5 MC Only)

The status of the MC key determines whether the Bank and Nudge keys apply to the CM408T or the MC.

• MC key lit: Bank keys control the MC (default state).

• MC key unlit: Bank keys control the CM408Ts.

Bank Keys

Press the Bank keys to move left or right one bank of four (MC) or eight (CM408T) strips.

Nudge Keys

Press the Nudge keys to move left or right one strip.

Strip Control

Strip Control

Setup

Flip

Home MC

Nudge Nudge

Bank Bank

Setup

Strip Control

Flip

Home MC

Nudge Nudge

Bank Bank

Layouts
Home Key

Press the Home key to move track 1 to the left-most strip.

Flip Key (System 5 MC Only)

The Flip key puts an entire row of knobs onto the faders:

• Press the Flip key and the entire first row of CM408T knobs is flipped to the faders and volume control flips onto the first 
row CM408T knobs. The Flip key lights solid to indicate that a different function is on the faders.

• Press the Flip key again and the second row of knobs is assigned to the faders. Pressing Flip eight times cycles through all the 
knob assignments and back to no knobs flipped to the faders.

Pressing the Flip key until it is not lit restores the faders to normal operation.

The Bank and Nudge buttons adhere to the convention that the console is being “moved” left or right. Therefore, 
the Bank Left button actually moves the tracks to the right, and Bank Right moves them to the left.



Layouts Key

Layouts are one of the MC’s most powerful features. Layouts allow the assignment of workstation tracks on the MC/S5MC surface 
to be stored and recalled. A Layout stores the mapping of tracks that are Direct Assigned to strips. They do not store mappings of 
underlying tracks that are automatically assigned to strips. Press the Layouts key to access the Assign and Layout touchscreens.
To create a layout:

1  Press the Layouts key in the Strip Control Setup section on the right of the MC.

2  Touch the desired number for the layout.

3  Touch the Store button.

4  Touch the Name button. 

Layouts Touchscreen
5  Type in a name for the layout and touch OK.
To recall or clear a layout:

1  Touch the desired layout’s number.

2  Touch the Recall or Clear button.

The Touch Recall button toggles Touch Recall on/off. When on, layouts are instantly recalled by touching the layout’s button in 
the grid. All other layout functions (Store, Name, Clear) are disabled while Touch Recall is on. First create, name, and store lay-
outs, then activate Touch Recall to have one-button access to them.

Touch Recall Mode to select from a popup menu the method to recall track assignments:

• Replace recalls all track assignments from the Layout and replaces the tracks currently assigned to the channels.

• Overlay recalls only the track assignments stored in the Layout to channel strips; all other channel strips retain their current 
track assignments.

Layout Recall from Soft Keys

1  Press Setup in the desired Soft Key section.

2  Add a Soft Key assignment type: MC. The default MC command is Recall Layout 1.

3  To assign Soft Keys to additional stored Layouts, assign subsequent numbers of stored Layouts from the Layout pull-down.
Bank 5 of the default Nuendo Appset is pre-programmed to display Layout Recall Soft Keys.
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Assigning Tracks to Strips
The MC has four channel strips. The System 5 MC can have a virtually unlimited number of CM408Ts. The MC and CM408T 
strips can be scrolled independently. The CM408T strips can have a Main and a Swap track assigned; the CM408T strip’s Swap key 
switches between Main and Swap layers.

When the MC connects to a workstation with EUCON DAW software (or Mackie Control Universal/HUI), it automatically 
populates the channel strips with DAW tracks. Track 1 placed on channel strip 1, and so on. Deleting/adding tracks or changing 
track order automatically updates the MC/CM408T strips.

Strips and Tracks

Any track can be assigned directly to a strip, similar to System 5’s mapping of channels to strips. Direct Assigned tracks do not 
move when the Nudge, Bank, and Home keys are pressed.

Use the Assign Touchscreen to direct assign tracks to channel strips (the MC’s four strips, or CM408T module channel strips for 
System 5 MC).
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To assign strips:

1  Press the Layouts key in the Strip Control section on the MC (top-right of the surface) to display the Assign Touchscreen.

2  Touch the tracks in the desired assignment order. The track numbers appear under Selection Order at the top-left.

3  Touch Insert Blank Strip at the point where a blank strip is desired. Blank strips appear as asterisks in the selection order.

4  Touch a selected track to remove it from the order. If the track is in the middle of the selection order, subsequent tracks shift 
up to take its place.

5  When finished creating the desired Selection Order, press the Wave key on the channel strip where the direct assigned tracks 
should start.

The MC automatically assigns the tracks beginning at that channel strip. Tracks currently direct assigned to channel strips shift 
to the right of all the assigned tracks.

• To remove direct assignments, touch the Unassign button. If none of the selected tracks are currently direct assigned, the Un-
assign button is gray and inactive.

• To direct assign just one strip, press that strip’s Wave and Chan Sel keys simultaneously. This pops up a list of track names 
to select on the CM408T’s display or MC Touchscreen. To remove the direct assignment, choose None at the top of the list.

When a track is Direct Assigned to a strip, the underlying tracks, both Main and Swap, are shifted to the right.

Assign Touchscreen



CM408T Channel Strips (System 5 MC only)
The CM408T channel strip is similar to the strip on the standalone MC with faders, but also has a four-character LED scribble strip 
display, and a high-resolution TFT display to show additional channel information, metering, pan, and EQ graphs.

The CM408T channel strip has the following attributes:
CM408T channel strip

Solo Key

Wave Key

Record Key

Chan Select  Key

Auto Write Toggle
Touch LED

Signal Meter

Auto Mode LEDs
On Key

Soft Knobs

Input Monitor

Knobsets

Swap Key

All Key

Dyn Master
EQ Master

Insert Master

Main Layer Display Swap Layer Display

Back Buttons

Page RPage L

Fader
See “Channel Strips” on page 45 for an explanation of these features.

Press and hold the strip’s left-top button then press the right button to navigate back (up) one level.
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Chapter 8: Monitors and Control Room
The Monitors and Control Room sections of the MC surface allow for controlling various monitoring setups. The MC does not 
process or route audio: it interfaces with a EUCON-aware application’s monitoring section or with the Euphonix Studio Monitor 
Express (SME) application.

Monitors, Control Room, and Talkback Sections
The Monitor section may be locked to your preferred application so monitor control is not interrupted by focusing to another work-
station or application.
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Control Room
The touch-sensitive knob controls the overall Control Room volume. The level is shown in the LED display to the right of the 
knob. The source is displayed in the lower LED display.
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Main Spkrs, Alt 1 Spkrs, Alt 2 Spkrs

These buttons switch the main Control Room feed between three sets of speakers:

Main Spkrs Up to 5.1 channels of Control Room Monitor Out.

Alt1 Spkrs Up to 5.1 channels of Control Room Monitor Out.

Alt2 Spkrs Stereo Control Room Out.

The selected source is displayed in the LCD to the right of the knob. Use SME to configure the Main, Alt1, and Alt2 audio sources.

Dim and Cut

The Dim key reduces the Control Room monitor level by a user-specified amount. While Dim is engaged, moving of the Control 
Room knob adjusts the dim amount. Dim amount can also be adjusted in SME.

The Cut key turns off the Control Room output.

Control Room Setup

This key opens the Control Room Setup Touchscreen. This selects the source for the Control Room feed, selects a folddown matrix, 
solos speakers, and sets the dim and talkback mic levels. 

Control Room section
For more information on the features in this panel, see “MC Control Room and Monitor Setup” on page 75.

Control Room Setup touchscreen



Monitors
The Monitors section of the MC surface can control up to two monitor outputs per page, labeled Monitor A and B in SME. Audio 
sources for Monitor A and B are configured in SME’s Main tab or the MC’s Touchscreen.

Touch-sensitive Knobs These knobs control the level (displayed in the LED display to the right of the knob) of their respective 
monitor outputs.

Up/Down Arrow Buttons These buttons switch the knobs from controlling the first two outputs to controlling the second two out-
puts.

Setup This key opens the Monitor Setup Touchscreen. Toggle selected Monitor A and B audio source(s) from the list displayed on 
the Touchscreen.

The top-right unmarked key is currently not implemented.

Clear and All Keys

Monitors section
The Clear Solo key turns off the solo on all DAW tracks even if several solo modes are supported (i.e., AFL, PFL, SIP).

The Clear Mute key unmutes all DAW tracks.

The All key is a System 5 MC only feature that, when lit, causes knobset selection on one CM408T channel strip to be applied to 
all CM408T channel strips. This key functions in Nuendo and Pyramix only.

The right unmarked key is currently not implemented.

Clear and All Keys
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Talkback

The Talkback button dims the Control Room output (according to the Dim Level) and activates the Talkback Mic channels as-
signed in SME (the Talkback Mic is active when the button is held down). Pressing the button momentarily latches it, and hold-
ing it down longer than the Latch Timeout setting (see Chapter 5, “Soft Keys”) makes it a momentary button; it releases when the 
button is released.

The Foot Switch jack can toggle Talkback on/off. For more information, see “Other Connections” on page 8.
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Chapter 9: Studio Monitor Express (Windows)

Studio Monitor Express (SME) is a powerful and flexible audio monitoring software application that runs on your Windows work-
station or a dedicated computer. It controls the routing between applications, external inputs, and ASIO hardware. SME outputs 
are routed to the audio I/O hardware and can be controlled from the MC’s Monitors section. SME can be considered a software 
version of a mixing console’s master and Comm section. 
SME provides a professional surround sound monitor mixer with up to two 5.1-speaker outputs and an additional stereo output 
each with level, cut, and talkback controls. SME can also be used to listen to external inputs without any other application open. 
SME can be installed (optional) during the workstation EUCON software installation.

Main

If you use a Mac, see Chapter 10, “Studio Monitor Express (Mac).”
Main tab controls:

• Mapping of Sources created in the Sources tab (see “Sources” on page 58) to Control Room, Monitor A and Monitor B, also 
selectable from the MC Monitor section’s Touchscreen.

• Monitor level sliders, control levels to Control Room, Monitor A, Monitor B, and correlates to the two Monitors knobs in the 
MC’s Monitors section.

• Cut: Cuts the Control Room signal completely; correlates to MC’s Cut button.

• Dim: Select the checkbox to attenuate the signal to the Dim Level set in the Config tab (see “Config” on page 62).

• Fix: Select the checkbox to set the signal to the Fixed Level set on the Config tab; correlates to MC’s Dim button.

• Phase: Select the checkbox to reverse the phase of the left channel (no surface control for this parameter).

Only sections created in the Sources tab appear in the Source boxes. To route a Source to a specific Monitor section, select it in 
the Source box for the desired monitor output.

Main tab
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When the workstation and MC are connected, the changes made in this tab are reflected in the Monitor and Control Room 
section on the surface, and vice versa.

Sources
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The Sources tab is used to create sources to SME’s mixer inputs. To create a source, select the Format (Mono, Stereo, or 5.1), select 
the Start Channel, type a name into the Name field, and click the Create button. SME creates the input monitoring section and 
adds it to the list of sections on the Main tab; it is now available for monitoring.

To create a section called CD Player: Select Stereo from the Format, select 1 as the Start Channel, type CD Player in the Name field, 
and press the Create button. This creates a stereo monitoring section for SME mixer input channels 1 and 2. The inputs to that 
section are defined in the Hardware I/P Patch tab (page 78), where a hardware input can be patched to each SME I/P.

SME O/P Patch

Sources tab
SME O/P Patch tab



The SME O/P Patch tab sets the physical output channels from each of SME’s monitors sections to the audio I/O hardware. Select 
the desired outputs from the Hardware O/P drop-down menus.

Application O/P Patch
The Application O/P Patch tab routes the application outputs (such as Nuendo) to the audio I/O hardware outputs and/or SME 
Inputs.

The Hardware O/P drop-down allows applications using the SME ASIO driver to route signal directly to the physical outputs (by-
passing SME).

The SME I/P drop-down allows applications using the SME ASIO driver to route signal into SME’s mixer. It is possible to select 
both a Hardware output and SME Input simultaneously, creating a mult.

Application O/P Patch tab
If the main outputs from your DAW application are Hardware O/Ps 1–6, they would typically be sent to SME O/Ps 1–6. However, 
it is possible to route the speaker outs to a different order (such as SMPTE surround format) than your monitors. For example, out-
put 3 (which your DAW expects is Right Front but you wish to be Center) can be routed to the actual output you use for Center.

Only outputs enabled in the Config tab are available from the Hardware O/P and SME I/P drop-down menus.
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Hardware I/P Patch
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The Hardware I/P Patch tab routes audio from the hardware inputs (Hardware I/P) on your workstation’s sound card to the Ap-
plication I/P and/or inputs of SME’s mixer inputs (SME I/P).

To pass audio from a physical input to an application, the hardware inputs (Hardware I/P) must be patched to Application I/P in-
puts. We recommend a one-to-one patch to make it easier to track the mapping between physical inputs and channel inputs in 
your DAW. However, it is possible to re-route a hardware input to a different EuIn input. For example, if the kick drum is on the 
24th physical input and you wish it to appear to your DAW that it’s on the 1st input, select 1 from the Hardware I/P 24’s Appli-
cation I/P drop-down menu.

If your CD player is routed to hardware inputs 40 and 41, select 1 and 2 from the Hardware I/P 40 and 41’s SME I/P dropdown 
menus respectively. This routes the CD player to Mixer inputs 1 and 2, which were set to a stereo monitoring section on page 75.

Only outputs enabled in the Config tab are available from the Application I/P and SME I/P drop-down menus. SME minimizes 
its CPU resources if you enable only the inputs you plan to use.

Hardware I/P Patch tab



Speakers
The Speakers tab allows attenuating and muting monitor section output levels. Drag the faders to adjust the level indicated in the 
field to the right of the fader. Click the Cut button to mute the output.

Each monitoring section has its own controls:

Control Room Main, Alt1, Alt2.

Monitors A and B.

Speakers 
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Config
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The Config tab displays the current sample rate, sets various levels, and enables the hardware inputs and outputs that patch to 
sources and destinations.

Set Dim Level This sets the attenuation amount (in dB) for the program signal when using the talkback function.

Set Fixed Level This sets the fixed output level, which is selectable in the Main tab for the Control Room output. This is useful for 
setups that have been calibrated to a specific db level and must maintain a fixed output level.

CPU Usage This meter shows SME’s CPU usage.

Sample Rate This shows the current sample rate to which SME is locked. This is only an indicator since the sample rate is 
determined by your sound card’s settings.

Settings This enables saving the current settings or loading previous settings, to quickly switch between different SME 
configurations.

Enable Hardware Ports This allows explicitly enabling or disabling each SME port. This limits the ASIO stream’s inputs and 
outputs monitored by SME, thus minimizing traffic on the PCI bus to only those ports necessary for the current setup. Only ports 
enabled here are available for routing to or from on the other tabs.

Configuring SME Talkback

To configure SME Talkback:

1  Connect the MC Talkback Mic to a microphone preamp with 48V phantom power (required).

2  Connect the mic preamp’s output to any input on your sound card.

3  In the Config tab, enable the input that you connected the preamp to on your sound card.

4  In the Config tab Talkback section, Set the desired Level, Destination and Action.

5  In the Hardware I/P Patch tab, route the Hardware Input to SME I/P “TB,” which appears at the bottom of the pull-down list 
(after channel 32).

Config Tab



Chapter 10: Studio Monitor Express (Mac)

Studio Monitor Express (SME) is a powerful and flexible audio monitoring software application that runs on your workstation or 
a dedicated computer and controls the routing between applications, external inputs, and Core Audio compliant hardware. SME 
outputs are routed to the audio I/O hardware and can be controlled from the MC’s Monitors section. SME can be considered a 
software version of a mixing console’s master and comm section.
SME provides a professional surround sound monitor mixer with up to two 5.1-speaker outputs and an additional stereo output 
each with level, cut, and talkback controls. SME can also be used to listen to external inputs without any other application open.

SME can be installed (optional) during the workstation EuCon software installation and includes a Euphonix Monitor Core Audio 
Driver for integration with applications you wish to use with SME on the Mac.

Main

If you are on Windows, see Chapter 9, “Studio Monitor Express (Windows).”
Main tab controls:

Mapping  Map Sources created in the Sources tab to Control Room, Monitor A and Monitor B, also selectable from the MC 
Monitor section’s Touchscreen.

Monitor Level Sliders Control levels to Control Room, Monitor A, Monitor B, and correlates to the two Monitors knobs in the 
MC’s Monitors section.

Cut Select this button to cut the signal completely.

Dim Select this checkbox to attenuate the signal to the Dim Level set in the Config tab.

Fix Select this checkbox to set the signal to the Fixed Level set on the Config tab; correlates to MC’s Dim button.

Main Tab
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Phase Select this checkbox to reverse the phase of the left channel (no surface control for this parameter)

Only sections created in the Sources tab appear in the Source boxes. To route a Source to a specific Monitor section, select it in 
the Source box for the desired monitor output. Sources can also be selected from the MC Monitors section Setup Touchscreen.

When the workstation and MC are connected, the changes made in this tab are reflected in the Monitor and Control Room 
section on the surface, and vice versa.

Sources
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The Sources tab creates sources to SME’s mixer inputs. To create a source, select the Format (Mono, Stereo, or 5.1), select the Start 
Channel, type a name into the Name field, and click the Create button. SME creates the input monitoring section and adds it to 
the list of sections on the Main tab; it is now available for monitoring. Channels 1–6 are used for internal busses from the appli-
cation using the Studio Monitor Core Audio driver. Channels 9–16 are reserved for external inputs, physical inputs to the audio 
I/O (i.e. an external CD player connected to the sound card inputs).

To route stereo audio from an application running on the Mac into SME, select Euphonix Monitor as the application’s Core Audio 
output driver. In the SME Sources tab, create a stereo source, name it (Logic, Nuendo, etc.), and set the start channel to 1. This 
creates a stereo monitoring source for SME mixer input channels 1 and 2. Enable the source in SME Main tab or from the MC 
Monitors section setup Touchscreen.

To create a source for a stereo external input (such as a CD Player): 

1  Select Stereo as the Format.

2  Select 9 as the Start Channel.

3  Type CD Player in the Name field.

4  Press the Create button. This creates a stereo source for SME mixer external input channels 9 and 10. The inputs to that source 
are defined in the Patch tab.

Sources Tab



Patching
The Patching tab routes the SME inputs from applications running on the Macintosh that are using the Euphonix Monitor Core 
Audio driver, external inputs to the workstation’s sound card, and the SME outputs.

The Input section (left) has eight selectable inputs from application outputs, and eight selectable inputs from the audio device 
(sound card) installed in your workstation. Each application used with SME must be set to use the Euphonix Monitor Core Audio 
driver.

Patching Tab
The Output section (right) sets the sound card outputs to which the SME’s Main, Alt 1, Alt 2, Monitor A, and Monitor B outputs 
are routed. For example, to change a 5.1 output from L-C-R-Ls-Rs-LFE to L-R-Ls-Rs-C-LFE, you can change the output routing 
instead of physically repatching the outputs to your monitors.

Only one application may use the Euphonix Monitor Core Audio driver at a time.
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Speakers
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The Speakers tab calibrates and mutes output levels. Drag the faders to adjust the level indicated in the field to the right of the 
fader. Click the Cut button to mute the output.

Each monitoring section has its own controls:

Control Room Main, Alt1, Alt2.

Monitors A and B.

Speakers Tab



Config
The Config tab displays the currently selected Core Audio device driver, Dim and Fixed output levels, and a CPU meter.

Audio Device This pull-down menu selects the Core Audio driver for the sound card to use with SME.

Config Tab
Set Dim Level Sets the attenuation amount (in dB) for the program signal when pressing the MC monitors section Dim button.

Set Fixed Level Sets the fixed output level for the Control Room output. This is useful for setups sending the output of the DAW 
to a separate mixer or router that has its own level controls, instead of controlling the output level from SME.

CPU Usage Shows SME’s CPU usage.

Talkback Setup
1  Connect the MC Talkback Mic to your audio interface.

2  Enable 48V phantom power for the Talkback Mic (required).

3  In the SME Sources Tab, create and name a Source Talkback (required).

4  In the Main Tab, enable Talkback for each section requiring Talkback routing (Main, Mon A, Mon B).

5  In SME Main Tab, press the Talkback button to enable Talkback.

6  Press the MC Talkback button to engage Talkback (follows latching/momentary logic).

7  If desired, you can connect a standard footswitch to the MC back panel Footswitch jack to toggle Talkback on/off remotely.

When the output driver is changed, patching is reset to default settings with no external or output patches enabled. Patches must 
be reassigned in the Patching tab.
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Chapter 11: DAW Integration

One of the most exciting abilities of the MC is dynamically detecting application and workstation switching. All controls on the 
surface switch to match the active application on the selected workstation. The MC automatically detects not only the applica-
tion but also if it is EUCON-aware, HUI, Mackie Control, or a generic application, and sets the control mode accordingly. 

The MC surface setups can be saved to the MC hard drive as User Sets, which contain Application Sets (referred to as App Sets) for 
each application. See “Workstation Control” on page 13 for information on assigning workstations to the Workstation keys. 

User and Application Sets

To view the MC User Sets or Application Sets:

 Touch Euphonix Menu > File. The File Menu opens, displaying the User and App Sets tabs.

A User Set is a folder that contains any number of Application Sets. User Sets can be saved and loaded from disk, and may contain 
variations of the various App Sets. For example, you might choose to create different User Sets for specific types of Nuendo 
projects such as Recording, Editing, Mixing, and Mastering. The relevant controls for each type of project are available on the MC 
surface. User Sets can also help if the MC is used by more than one operator by recalling setups for each.

Upon startup, the MC loads the Root User Set, which is the default User Set containing App Sets for many of the most widely used 
applications. You can modify and save the Root User Set or create a totally new User Set.

An App Set is an XML file that contains metadata defining Soft Keys assignments for each application, and also includes text, icon, 
and Soft Key color. The MC ships with App Sets for many applications, but new App Sets can be easily created for applications 
without one. Switching applications causes the MC to automatically load the focused application’s App Set (if it exists).

Because of the flexibility of the MC Soft Key programming, App Sets can also be very useful for sending key commands to generic 
applications (such as Adobe Photoshop, Acid, or SoundForge).

An App Set stores all functions specific to an application:

• All banks of 16 Edit Control Left Keys

• All banks of 16 Edit Control Right Keys

• All banks of 24 Soft Keys
A Default Application Set is provided and used in case there is no App Set for the application currently in focus.

Content of an Application Set
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User Sets
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User Sets store a collection of App Sets. The User Sets Touchscreen displays a file hierarchy in the columns from left to right. For 
example, the Root User Set is in the MCUser folder in the User Sets folder. Each column scrolls with the up/down arrows below 
the column.

Copy Copies the selected User Set into the Clipboard.

Paste Pastes the User Set in the Clipboard and creates another with the same name appended by Copy (exactly like the Windows 
Explorer or Mac OS Finder).

Reveal Opened Displays the User Set currently open and in use.

Restore Root Restores the Root User Set, the default User Set that ships with the MC. The Root User Set contains Appsets for the 
most widely used applications. Use this function only to restore the MC Root User Set back to factory settings; you will lose 
changes in a modified Root User Set.

File-User Sets Touchscreen



Application Sets
An Application Set stores the Soft Key assignments on the MC surface. An unlimited number of Application Sets can be created, 
one for each of the applications you use.

To create a new Application Set:

1  Connect the MC to the workstation on which the new application resides and runs.

2  Open the application if it is not already open. If it is open, bring it into focus as the front application.

3  Open the App Sets Touchscreen (Euphonix Menu > File). Make sure the App Sets tab is selected.

4  Touch the New button. The Application Set is created.

5  Program the MC Soft Keys as desired (see Chapter 5, “Soft Keys”).

6  When finished, touch Save to store the programming.

The new Application Set now appears in the list with all MC App Sets.

File-App Sets Touchscreen
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Avid Pro Tools
Pro Tools 9.0 and higher is fully EUCON-aware. 

Enabling EUCON in Pro Tools

To enable EUCON control in Pro Tools:

1  Launch Pro Tools.

2  Choose Setup > Peripherals, and click the Ethernet Controllers tab.

3  Select Enable EUCON.
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4  Click OK. You do not need to configure any other Ethernet Controllers settings. These settings do not apply to EUCON.

Pro Tools scans your system until it identifies attached EUCON-compatible controllers. When Pro Tools finishes scanning your 
system, your controllers are ready to use with Pro Tools.

Confirming Communication with Pro Tools

To confirm installation and communication:

1  Open a session if one is not already open.

2  Verify that the Mix window displays a border around the names of the Pro Tools tracks that are currently displayed on the 
MC Pro Surface.

Pro Tools Setup > Peripherals > Ethernet Controllers
3  Verify that the displays on your controllers show track names, location, or other session data, depending on the configuration 
of your MC Pro or System 5 MC.

Track name color to indicate control by MC Pro (number of tracks under simultaneous control varies with MC Pro/System 5 MC configuration)



Steinberg Nuendo
Steinberg’s optional EUCON device driver enables fully integrated control of all of Nuendo’s functions from the MC control 
surface, including channel operations from the CM408T channel strips (System 5 MC).

Configuration

To enable Nuendo to work with the MC you must obtain a Nuendo EUCON Adapter license from Euphonix and download it to 
your Syncrosoft USB protection device (dongle)

To obtain a Nuendo EUCON Adapter license: 

1  Close all open applications.

2  Start the Nuendo License Control Center by choosing Start Menu > Steinberg Nuendo 4 > License Control Center.

3  Choose License Download from the Wizards menu.

4  Choose License Transfer to transfer an existing Nuendo EUCON license to a new USB dongle.

5  Enter the activation code for Nuendo EUCON provided by Avid.

6  Make sure you are downloading the correct license, then click Next.

7  Make sure your USB dongle is attached to your workstation, select the target device to which the license will be assigned, and 
click Next.

8  Click Download to transfer the license onto your USB dongle.

9  Close the wizard and open Nuendo.

The Nuendo EUCON Adapter must be installed during the EUCON-WS software installation. Note that this is the MC Client 
Nuendo adapter. For Nuendo to communicate with the MC, Nuendo’s EUCON device must be added in the Device Setup dialog. 

To add the Nuendo EUCON device to Device Setup:

1  Choose Device Setup from the Nuendo Devices menu.

2  Click the + button (add) on the top left. A pop-up list of devices appears. EUCON should appear near the top of the list. If not, 
close Nuendo and use the EUCON Workstation installer to install the Nuendo EUCON Adapter (this is optional in Windows in-
staller; it installs by default with the Mac installer).

3  Select EUCON from the pop-up list.

The EUCON device is added and the MC surface immediately updates with the Nuendo default App Set. The MC faders and Soft 
Knobs display track functions. On the System 5 MC, Nuendo channels are displayed on the CM408T strips, beginning with chan-
nel 1 on the left-most strip.

Nuendo Monitor Setup

The MC Monitors section can control the Nuendo Control Room Mixer. The Monitors and Control Room sections (top-left of the 
MC surface) mirror their related controls in Nuendo: Adjusting the MC controls updates Nuendo controls and vice versa.

To set up the Control Room in Nuendo:

1  In Nuendo, choose Devices > VST Connections.

2  Click Studio (right-most tab).

3  Click Enable Control Room at the top-right of the window.

The Nuendo Control Room Mixer is now enabled. You may now set up the monitoring busses and talkback source.

4  Right-click in the window below Bus Name.
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Nuendo has the following busses available:

External Input (6) Create inputs for external sources to monitor in the control room.

Talkback (1) The Talkback bus is controlled by the Talkback button on the MC surface.

Studio (4) Create mono or stereo studio outputs for talent to monitor. These can also be selected for the Control Room output.

Headphone (1) The headphone output is a dedicated stereo downmix for the control room headphones.

Monitor (4) Create up to four speaker outputs (all formats up to 8.1) controlled by the Main Spkrs/Alt 1 Spkrs/Alt 2 Spkrs buttons 
on the MC surface.

5  Click on a bus to create. A dialog appears to name the bus and select its format (up to 8.1 depending on the bus). When finished, 
it appears in the Studio tab.

6  Click Not Connected in the Audio Devices column of the bus name just created. Select the hardware driver to use with that bus 
from the popup menu (your ASIO soundcard).

7  Click the + button next to the bus name. 

The display expands to show the input or output channels that are part of that bus. After selecting the hardware, Nuendo auto-
matically assigns each output or input to the first available hardware port (such as MADI 1, MADI 2). To reassign these, click in 
each channel’s Device Port column and select the proper port from the pop-up menu. For example, if Monitor 1 is a 5.1-channel 
system and should go to outputs 20–25, click on each output (L, C, R, LFE, LS, RS) and assign them to ports 20–25.

8  When using the Nuendo Control Room Mixer, you may want to lock the MC Monitor section to retain Monitor control when 
Nuendo is not the application in focus. To do so: 

• Press and hold the MC keyboard Shift Key and press the MC Monitors section’s Setup button.

Control Room

The MC Control Room section switches the output between Nuendo Monitor busses (output busses going to speakers). The MC 
Main Spkrs/Alt 1 Spkrs/Alt 2 Spkrs buttons switch the output between the first three monitor busses created. The fourth Monitor 
bus is accessed by opening the Control Room window in Nuendo (Devices > Control Room) and clicking the D button (bottom 
right).

• The Dim key lowers the volume to the selected Monitor bus by the specified Dim level (default = –30 dB). The Dim level can 
be adjusted by turning the Control Room knob while DIM is selected. 

• The Cut key cuts the output to the selected Monitor bus.

• The Soft Knob controls the level of the selected Monitor bus. When the knob is touched or adjusted the level appears in the 
LCD display to the right of the knob.

Monitor

The Monitors section controls the levels of the four Studio busses, which can also be selected as sources for the Control Room sec-
tion. This allows dynamic adjustments of the headphone feeds to the talent. The name of the Studio bus being adjusted appears 
in the LCDs next to the two Soft Knobs. Move the knob to adjust the output level for that Studio bus and the output level appears 
in the LCD. To switch between monitoring Studio busses 1/2 and Studio busses 3/4, press the up or down arrow keys and the 
LCDs update to show which Studio busses are being controlled.
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MC Control Room and Monitor Setup
Press the Control Room Setup button on the MC to open the Control Room Setup Touchscreen. There are three tabs:

Source Selects what the Control Room section monitors. The Mix bus, the default bus in Nuendo’s VST Devices Output tab (or-
ange speaker icon next to its name) is always available. If Studio or External Input busses have been created, they also appear.

Speakers Allows soloing or muting of one or more speakers. Touch the speakers in the Speaker list to turn them on. They change 
to yellow to show that they are active. The Left-Right option is a shortcut for a stereo feed: it automatically solos the Left and 
Right speakers. Touch the ON button to the left to turn on/off all solo assignments.

Talkback If a Talkback bus was created in Nuendo’s VST Devices Studio tab, pressing the MC’s Talkback button enables the talk-
back function in the Nuendo Control Room Mixer. The Talkback Mic Level adjustments on the Touchscreen do not function 
with Nuendo’s Control Room Mixer at this time.

MC Control Room Setup Touchscreen

Due to Nuendo’s internal mixing structure, only one external input can be monitored at a time. Regardless of how many of the six 
External Input busses are used in the VST Connections > Studio tab, there will be only one Ext. selection on the MC Touchscreen. 
To switch between External Inputs, use Nuendo’s Control Room Overview (Devices menu) and click on the available External 
Input crosspoint boxes.

The Insert Disabled and Control Room Variable controls shown on this tab are not enabled for use with Nuendo’s Control Room 
Mixer at this time.
Talkback tab in Control Room Setup Touchscreen
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Monitor Setup
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The Monitor Setup key opens the Monitor Touchscreen, which controls the source for each Studio feed. Each Studio feed has its 
own tab (Monitor A–D), and each tab lists the possible sources (External Input, Main, and Aux busses). To select a source for a 
Studio bus, touch the tab of the desired bus then touch the source to assign; source selections intercancel.

Talkback

Once the Talkback bus is set up, pressing the MC Talkback button automatically dims all output bus levels and routes the Talk-
back bus output to all output busses with TE enabled in the Nuendo Control Room Mixer (green when enabled). To utilize the 
MC built-in talkback mic, connect the XLR talkback mic output on the back panel to an input on your Nuendo workstation hard-
ware (ASIO sound card), then select that input as the source for the Talkback bus (Device Port in the Studio tab of the VST Devices 
window). The MC built-in talkback mic is a condenser microphone and requires 48-V phantom power.

Nuendo-Specific MC Controls

This section discusses MC controls that have a unique function within Nuendo.

Soft Keys

Soft Keys may be programmed with three Nuendo-specific commands by selecting MC type commands.

Parameter Collect Stores automation data into the MC internal memory buffer for punching into Nuendo’s automation system 
at specified locations.

Parameter Punch Transmits automation data collected into the MC internal memory.

Read/Write All Automation Used in conjunction with Parameter Collect and Parameter Punch to isolate automation system from 
automation being collected into the MC internal memory buffer.

Monitor Touchscreen

The rear panel Foot Switch jack can be used to toggle Talkback on/off (see “Other Connections” on page 8).



Multiple Track Selection

Multiple track selection from the surface depends on the Track Selection mode preference found on the General Preferences page. 
Track Selection mode can be set to Intercancel or Sum.

Intercancel Multiple track selection from the surface is not possible.

Sum Multiple track selection is accomplished by pressing Chan Select either from the MC Touchscreen or on the channel strips. 
De-select a selected track by pressing Chan Select again.
MIDI Tracks

Nuendo MIDI tracks are supported on the surface. The Insert, Dyn, Pan, Insert, and Mix Knobsets can be used with Nuendo MIDI 
tracks.

The Insert Knobset has only four insert slots (audio channels have eight). Insert MIDI plug-ins can be modified and automated 
in the Insert Knobset on MIDI tracks. Bypass has no effect on MIDI inserts.

The Pan Knobset allows stereo-only panning of MIDI devices. On a joystick MC, the joystick controls stereo-only panning on the 
attentioned MIDI track.

The Dyn Knobset selection opens the first Compress MIDI plug-in when loaded into one of the insert slots (inserting MIDI 
plug-ins is only possible with the trackball at this time). Knobs in the Dyn Knobset allow modification and automation of 
parameters of Nuendo Compress plug-ins.

VSTi Tracks

VSTi tracks have only slightly different features than audio channels. The Record and Monitor buttons are disabled, Inserting of 
VSTi’s is only possible with the trackball, and the Input Knobset is non-functional. Otherwise, VSTi tracks function identically to 
audio channels.

Solo Preferences Touchscreen
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EUCON Adapter Preferences

This section describes EUCON Adapter Preferences for track assignment and transport control.
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Dynamic Selection of EUCONized Tracks

A list of checkboxes determines which channel types are modeled in EUCON. If a certain channel is available in Nuendo and the 
corresponding checkbox is checked, the channel can be accessed through EUCON and is deemed EUCON-ized.

All channels except Input channels are EUCON-ized by default and appear on the MC/S5MC surface. Navigate to Nuendo > 
Devices Menu > Device List > EUCON to choose which types of tracks are EUCON-ized and displayed on the surface. This is useful 
to eliminate tracks from the surface, reduce memory usage, and reduce the time needed to build the EUCON mixer model when 
connecting, adding, or removing tracks from the Nuendo project.

To enable/disable EUCON-ized tracks:

1  Navigate to Nuendo > Devices Menu > Device List > EUCON. Checkboxes appear next to each type of Nuendo track.

2  Select the types of tracks to map onto the surface by selecting the checkbox next to each type. Tracks without a checkmark do 
not appear on the surface. This setting applies only to the open project. 

Nuendo Transport Preferences

Two Nuendo transport control modes are available for the MC. Toggle the modes from the Tape machine style transport option 
in the Transport behavior section of the EUCON module. The two transport modes affect the operation of the Stop, Fast Forward 
and Rewind buttons in the following manner:

Tape Machine Style Transport Not Checked

Stop The MC Stop button copies the Nuendo stop button.

Fast Forward/Rewind The FF/RW buttons function as EUCON Momentary/Latch-Switches. If the button is pressed and released 
quickly, the switches behave momentarily, resembling the way these buttons work in Nuendo. If the FF/RW buttons are held 
down longer than the latch time set in the Preferences-Setup page, they latch.

Tape Machine Style Transport Checked

Stop The MC Stop button halts the transport and keeps the play head at the current position (even multiple presses), independent 
from Nuendo preferences.

Fast Forward/Rewind The FF/RW buttons always latch independent of the MC Latch Time preference. Repeatedly pressing the 
same FF/RW button has no effect. The current action can be stopped by pressing the opposite wind button, stop, or play. The 
FF/RW also stops if it reaches the beginning or end of the project.

Nuendo EUCON Preferences



Number of Knob Sets to Cache

This limits the amount of surface display data that is stored in the Nuendo cache memory on your workstation. Increase this set-
ting only if you notice slower surface update times. Max setting = 999. 

Studio Sends on MC and CM408T Aux Send Knob Set Page 2

The Studio sends are on page 2 of the Aux Send Knobset. Knob 1 is send 1’s pan, Knob 2 is send 1’s level. Knob 2 switches control 
on/off and pre/post, exactly like the Aux knobs. The four-character displays show S1 L for the level and S1 P for the panner. All 
subsequent studio sends are arranged accordingly.

Merging Technologies Pyramix
Pyramix is a DAW solution comprised of:

• Dedicated DSP cards perform real-time mixing and editing (such as edit/copy a clip while playing a project).

• Pyramix Virtual Studio software optimizes the DAW environment to your workflow.

Pyramix has flexible monitoring, recording, signal routing, and processing capabilities and supports unlimited internal tracks 
and up to 128 mixer channels. Merging Technologies has created a default Application Set that can be easily modified to suit your 
preferred working style.

Configuration

To enable the use of the MC with Pyramix, the EUCON adapter for Pyramix checkbox must be selected during the MC Client soft-
ware installation. Then add the MC as an installed controller in Pyramix:

To configure:

1  Launch the Pyramix Virtual Studio software.

2  Press the Pref key on the top bank of the MC Soft Keys. The bank changes to show two options:

Home Restores the first bank of soft keys

Show Settings Opens the Pyramix Settings dialog box (alternatively, choose All Settings from the Settings menu in Pyramix Vir-
tual Studio).

3  Click Show Settings. A dialog appears showing a list of the various types of adjustable settings on the left side.

Currently, the studio sends inspector pane or extended mixer channel strip cannot be displayed from Aux Knob Set page 2. 
You must use the trackball to select the Studio Sends view from the Nuendo Inspector or extended mixer channel strip.
Pyramix Settings
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4  Click Controller. The right pane shows any installed controllers. However, at this point the pane is empty unless other interface 
controllers have been installed previously.

5  Click the Add button.
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6  Type the desired name for the MC in the Name field (for example, type “MC in Studio 2”).

7  Select the Enable checkbox.

8  Choose OASIS from the Driver pop-up menu.

9  Click the Properties button next to the Driver pop-up menu.

Controller Properties dialog
OASIS Configuration Properties dialog
10  Select EUCON from the Transport pop-up menu.
If EUCON is not in the pop-up menu, it is probably because the MC Client is not running. Check that the MC Client menu tray 
icon is present. If not, launch the MC Client using the shortcuts in the Start menu or the Euphonix folder. Leave the Station ID 
at its default setting of 1 unless you have multiple controllers, in which case simply increment the setting. For example, if f two 
controllers are installed, set the Station ID = 3 for the MC.

11  Click OK to exit that dialog, click OK in the Controller Properties dialog and click OK in the General Settings dialog.

12  Close Pyramix, reboot the workstation, and then open Pyramix Virtual Studio. Pyramix will not connect to the MC properly 
without rebooting the workstation.

The MC loads the default Pyramix Application Set if a project is open. Otherwise, the Application Set will not be loaded, but the 
Soft Keys at the top-left illuminate to show that EUCON communication is enabled.

Since the MC only accesses the functions of Pyramix Virtual Studio, this manual does not document those functions. Refer to the 
Pyramix Virtual Studio manual for specific information.



Getting Started

To quickly get started:

1  Open Pyramix Virtual Studio by double-clicking the shortcut on the Windows desktop, or select it from the Start menu.

2  Use the right trackball and keyboard on the MC to control the Pyramix workstation.

When Pyramix first launches (before a project is loaded), the default MC Application Set displays the following options on the 
MC Soft Keys: Pref, View, Edit, Automation, Open, Save, and New Project From Template). For those unfamiliar with Pyramix, we sug-
gest starting with a template project that has tracks, routing, and monitoring already set up. Merging Technologies has created 
several projects to easily and quickly begin working with Pyramix.

3  Press the New Project From Template Soft Key. A dialog box opens containing the contents of the Pyramix Template folder. 
Double-click on the Euphonix folder to choose from the template projects created by Merging Technologies.
4  Select the desired template.

5  Select a media folder to store your recorded sound files. Note that if previously created sound or media files are added to your 
project, they will not be copied to this folder. Pyramix creates links to those files but leaves them in their current location. 

Pyramix Template Folder
6  Click Mount. Pyramix opens the Mount dialog box.

Specifying a Media Folder

See the Pyramix manual for more information.
7  Click Browse to select a folder or create one to store all the media files created with the project.

Mount dialog
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8  Click OK to exit that dialog, and then click Mount. The dialog box that opens names the project and assigns its location. We rec-
ommend saving it in the media folder you selected or created.

9  Click OK and the new project is set up.

Prior Pyramix users can simply open existing projects and the MC will control Pyramix functions.

Monitoring

The MC Monitors section can control the Pyramix built-in monitor.

To create a speaker set:

1  Choose View > Windows/Tools > Monitor or press the Monitor Soft Key above the MC keyboard (the MC must be connected to the 
Pyramix workstation and added as a controller in Pyramix). This opens the Pyramix monitoring window.

2  Click the Configure button at the top-right. The window changes to the Speaker Set configuration.

3  Click Add Set on the left. Pyramix adds a speaker set and prompts you to name it.

4  Type Main Spkrs (use exact capitalization and spacing).

5  Repeat Steps 3 and 4 for Alt 1 Spkrs and Alt 2 Spkrs.

6  Create the appropriate patches for the new speaker sets (consult the Pyramix manual for specific information).

The MC can now switch between those speaker sets using the Main Spkrs, Alt 1 Spkrs, and Alt 2 Spkrs Control Room section but-
tons on the MC surface. The Dim and Cut controls also function as expected on the selected speaker set. The Soft Knob controls 
the level of the currently selected speaker set.

Talkback

Follow these steps to use the MC Talkback button with the MC and Pyramix:

1  Create a channel in your Pyramix project and name it Talkback. Use this exact capitalization and spelling.

2  Close and re-open your project. This causes Pyramix to rebuild its mixer.

Holding down the MC Talkback button unmutes the channel named Talkback.

We recommend routing the MC talkback mic output into your Pyramix system physical inputs. This enables sending the talkback 
to headphone feeds, remote studios, or other via aux sends.

Plug-in Integration

The MC can control Pyramix plug-ins using the Soft Knobs (or the CM408T knobsets for System 5 MC). Euphonix supports most 
Pyramix plug-ins and continues to add others. Pyramix plug-ins cannot be instantiated from the surface at this time; however 
plug-in parameters can be edited and automated from the touch-sensitive Soft Knobs.

To edit a Pyramix plug-in:

1  Select the desired channel either from the Tracks Touchscreen, or on an MC or CM408t strip.

2  Press the Inserts Soft Knob key on the MC or knobset key on CM408T. The Soft Knobs (or knobset on the CM408T) change to 
reflect the plug-ins available for editing.

3  Press the Soft Knob top or the related Soft Key to edit the plug-in. See “Knob Cells” on page 42 for instructions on editing pa-
rameters using the Soft Knobs.

Open the General Settings dialog (Settings > All Settings) after loading a template project and check that the following settings suit 
your needs: frame rate, sample rate, sync format, and source/destination.
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MOTU Digital Performer 6.02 and 7 (EUCON)

Configuration
1  In Digital Performer 6.02 (or higher), go to Setup > Control Surfaces.

2  Press +.

3  Select EUCON from the pop-up menu.
Digital Performer6 - Add Control Surface
Listen to Control Surfaces in Background should be enabled at all times when using EUCON Control Surface Driver.
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HUI Applications
HUI is a control protocol developed by Mackie that works with most DAWs. The HUI protocol is limited by the original HUI spec-
ification, and thus the MC must emulate the physical controls of the actual HUI hardware. The original HUI had a two-line 
60-character display, which is displayed as a black box with white characters on the top-right of the MC Touchscreen when con-
trolling a HUI application. The four left-most Soft Knobs act as the HUI V-Pots. The Soft Keys emulate the other buttons of the 
HUI hardware.

Avid Pro Tools 8 and Lower

Pro Tools 8.x and lower uses the HUI protocol to communicate with the MC. Starting with version 9, Pro Tools supports the EU-
CON protocol. 

Setup and Configuration (Mac)

To configure EuPreferences on Mac:

1  Go to System Preferences and open Euphonix Preferences.

2  Open a Finder window and locate the Pro Tools application inside the Digidesign folder. Drag Pro Tools into the Euphonix 
Preference Pane.

• The protocol should be set to HUI by default. If not, change it to specify HUI.

• Make a note of which MIDI ports are set here also. EuPreferences automatically configures groups of four ports, and will in-
crement them if other entries exist.

3  When you exit you will be notified to restart.

• After you have configured or changed Euphonix Preferences, the system will need to be rebooted. This will relaunch 
MIDIServer and also start ExHUI. 

For troubleshooting, it is important to know that ExHUI and MIDIServer both need to be running on your system. To verify this, 
check Activity Monitor on your Mac.

Setup and Configuration (Win)

For Pro Tools 9.x, see “Avid Pro Tools” on page 72.
To configure EuPreferences on Windows:
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1  Open the EUCON Control Panel from the Control Panel in Windows.

2  Click ADD and Browse to the Digidesign program folder.

3  Select ProTools.exe.

4  Make sure the Protocol is set to HUI (default) and define the ports (1-4 default).



5  Click Apply and restart the workstation.
• After you have configured or changed Euphonix Control Panel settings, the system will need to be rebooted. This will re-
launch the virtual MIDI driver and also start ExHUI. 

Set Up Pro Tools Peripherals

 Euphonix Control Panel
To configure Pro Tools: 
1  Launch Pro Tools. 

2  Go to Setup > Peripherals.

3  In the Peripherals setup window, go to the MIDI controllers tab. Here you will need to specify the number of HUI devices to be 
used in your system, and which MIDI ports they will communicate on.
Deciding how many HUI modules to configure will affect how banking behaves and determines how many tracks are accessible 
from the touch-screens. A general rule of thumb is to create one HUI for each CM408T module in a S5MC, or for each Surface 
module in an Artist Series configuration.

Pro Tools Peripherals
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Understanding Banking & Surface Mapping

Layers and Banking

Banking (and nudging) the surface in HUI mode behaves differently than standard EUCON surface banking. In standard EUCON 
applications, all tracks are directly available, and banking simply slides the surface left/right thus exposing other tracks on the sur-
face.

In HUI mode, however, EUCON sees only the HUI layer. Standard surface banking would simply move the location of the HUI 
tracks on the surface, and would not expose other tracks in Pro Tools. To do that, you must HUI Bank. Current Bank and Nudge 
buttons from the EUCON surfaces has been set to provide HUI-Banking in order to simplify this.
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In the illustration above, two HUI modules have been assigned in Pro Tools. By default, Pro Tools maps channels 1- 16 to the 16 
available HUI strips. These HUI strips are then seen by the EUCON surface and are mapped respectively to surface strips 1-16.

Pressing BANK (or Nudge) from the surface, will move the HUI layer left or right. Banking will move the HUI layer by the number 
of HUI banks assigned: in this case two (16 tracks) resulting in Pro Tools channels 17 - 32 being mapped to the HUI layer and thus 
updating the data sent to the surface.

In HUI mode, Surface Banking is disabled. This means you cannot move the surface mapping of HUI strips using Bank or Nudge 
as you would in standard EUCON applications.

HUI Nudge Wheel Mode

The HUI Nudge wheel mode lets you scroll the HUI banks through the Pro Tools mixer quickly using the MC Jogwheel. 

The Nudge command is located in the Left Edit section of EUCON commands. It is also pre-programmed in the default AppSet for 
Pro Tools in the Left Edit section, bank 1.

Home/End

The HOME key in HUI also behaves differently than the standard EUCON surface command. EUCON applications provide Surface 
Banking and is controlled by the surface layer. The application is completely unaware of this and doesn’t need to be. When the 
HUI layer is introduced, Surface Banking is disabled and HUI Banking is enabled. The HOME key now becomes a HUI command.

Pressing the HOME button slides the HUI layer to the far left such that Pro Tools Channel 1 is mapped to the last available HUI 
Strip. This means you will see Pro Tools track 1 on the Right most Surface strip.

The END key is currently not available in HUI mode. No END key exists on the MC Pro surface. 

HUI Banks and the TouchScreen

All HUI strips are visible and accessible via the touch screen. The amount of tracks is always set by the number of HUI banks as-
signed in Pro Tools. The maximum is 4 banks or 32 channels. The tracks on the touch screen always match the HUI bank colors.

Pro Tools - HUI - Surface layers

HUI and Mackie Control protocols do not pass Track Number data; track numbers will always appear blank on EUCON surfaces 
when using these modes.



Surface Mapping and Direct Assign in HUI

One of the most powerful features of EUCON Control Surfaces is the ability to map any DAW channel to any Surface Strip. This 
is called Direct Assign. When using HUI mode it is important to remember the relationship between the Surface, the HUI layer 
and Pro Tools.

It is possible to map HUI Strips to the surface in the same fashion as EUCON applications. The difference, however, is that only 
the HUI Strips are mapped, and not the actual Pro Tools channels. This means that once HUI Strips are mapped, the HUI layer 
can “move” underneath (by Banking or Nudging), and the Pro Tools tracks as they appear on the surface will change accordingly.

For example: say you open your Pro Tools session and have 2 HUI modules assigned. By default, channels 1-16 are assigned to 
HUI Strips 1-16 and then onto Surface Strips 1-16 respectively. You proceed to Direct Assign HUI Strips 5-8 onto the 4 MC Control 
faders (or MC Pro fader unit). When you HUI Bank, the HUI Layer “moves” to the right by 16 channels (2 banks). Pro Tools chan-
nels 17-32 are now assigned to HUI Strips 1-16, and the 4 Surface Strips assigned earlier now display Pro Tools channels 21-24 
(5+16=21 and 8+16=24). The Surface Mapping did not change; the HUI layer simply moved, passing on a different set of Pro Tools 
channels to the surface through the HUI layer.
In the image above, you can see that Surface Mapping takes place between the HUI layer and the Surface Strips. HUI Strips are that 
are mapped to the Surface simply pass on the track data from the assigned channel in Pro Tools.

Storing Layouts

It is currently not possible to store Layouts as part of a Pro Tools session. EUCON-aware applications have this added benefit 
which enables this data to be stored with the session / project files. Using Pro Tools markers with Show / Hide track data can 
achieve similar results. These can also be recalled from the surface using Soft Keys.

HUI layer and Surface Mapping
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Surface Knob Sets in Pro Tools

There are eight knobsets accessible from any EUCON surface. Each knobset is used to provide the operator with access to param-
eters in a way that is intuitive and easy to navigate. Each knobset consists of eight knob cells. Each knob cell contains a 
Touch-Sensitive Encoder (knob) that doubles as a press button (knob-top), and two buttons: Sel and On. Additionally, each knob 
cell has an associated display. The eight knob cells are arranged as follows for each control surface module:
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The HUI controller also uses knobs to access insert parameters within Pro Tools. The HUI, however only has four knobs used for 
controlling parameters along with 4 buttons used to toggle binary (on/off) switches and a fifth knob used for scrolling through 
pages of controls. These controls are mapped to the EUCON control surface to provide the best possible access.

CM408T & MC-Soft Knobs knob-cell numbers
HUI surface controls
The HUI controller also provides a single encoder used for each channel (or fader) on the surface. These eight encoders display 
channel specific information regardless of what the four DSP encoders are displaying. The channel specific encoders will display 
the following: Pan, Input, Output and Sends. These channel encoders are also mapped to the EUCON control surface.

The Knob Sets

There are eight knobsets available on any of EUCON control surfaces. Below is a brief overview of each:

• INSERTS (*): full access to the HUI DSP edit / assign parameters

• INPUT: view / assign channel Input assignments

• DYN: an advanced surface mapping of the INSERT knobset dedicated to Digidesigns Dynamics plug-ins

• EQ: an advanced surface mapping of the INSERT knobset dedicated to Digidesigns EQ plug-ins

• SENDS (AUX): controls Sends A-E

• PAN: access Pan controls (Pan L & Pan R)

• GROUP (GRP): special knobset used to directly emulate the HUI DSP Edit / Assign section. Also provides control of any 
plug-in opened from the Pro Tools GUI. (also called Legacy Mode - GRP is rarely used.)

• MIX: view / assign channel Output assignments

The numbers displayed in the above image indicate which EUCON knob cell each HUI control is generally assigned to when using 
the INSERT knobset mode. The main encoders are mapped to 5-8 to place the controls within easy reach when using the S5MC 
408T modules, and to display the switch parameter name on its own display.



Accessing Knob Sets

CM408T

The eight knobsets are accessed directly from each channel strip.

• INSERT, GRP, EQ and DYN knobsets provide access to the DSP Edit / Assign controls of the corresponding channel using the 
8 knob cells of that strip.

• Pan, Aux, Input and Mix are global. These knobsets will toggle the display on all channels on the surface. Additionally, these 
knobsets use only the bottom knob cell (8).

• The default knobset is PAN.

MC Soft Knobs

The eight soft-knobs on the MC Pro can also be used to access the eight knobsets. By default, this section will display parameters 
specific to the attentioned track. The default knobset is always PAN.

To access other knobsets press BACK. The 8 LCD displays will now show the eight knobsets. Press the corresponding LCD button 
or knob-top to enter the desired knobset.

INSERT (*)

The INSERT knobset will display the inserts on the attentioned channel. The INSERTS will be displayed on knob cells 5-8. 

To assign inserts:

1  Press CFG.

2  Turn knob on desired insert.

3  Press ON button (flashing green)

4  To cancel press CFG without assigning or return to PAN knobset.

To unassign inserts:

1  Press CFG

2  Turn desired insert knob to No Insert.

3  Press ON to assign No Insert.

Modifiers work as normal (OPT = do to all, OPT+SHFT = do to all selected)

INPUT

The INPUT knobset shows currently assigned inputs. All surfaces will display this in NORMAL mode across all channels.

To assign input:

1  Turn knob to desired Input.

2  Press ON to assign (flashing green). Modifiers work as expected: To cascade inputs across multiple selected tracks, hold 
Opt+Shift+Command (Mac) and assign.

DYN

The DYN (dynamics) displays the first dynamics plug-in on the knobs. It is important to note that DYN knobset is simply a special 
case mapping of parameters from the INSERT knobset. This is dedicated to provide control of dynamics plug-ins in a way that is 
consistent with other EUCON enabled DAW systems.

If no dynamics plug-in exists, the channel defaults back to INSERTS view.
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EQ

The EQ knobset is the same as DYN but for EQ plug-ins. It is also important to note that EQ knobset is simply a special case map-
ping of parameters from the INSERT knobset. This is dedicated to provide control of EQ plug-ins in a way that is consistent with 
other EUCON enabled DAW systems.

The special mapping the EQ plug-in parameters lets you make use of all eight knob cells for EQ editing:

• Each band of EQ uses two knob cells. one each for GAIN and FREQ. To access Q (or bandwidth), press the SEL button on the 
FREQ knob cell. This means you have access to four fully parametric bands of EQ at one time. This method of displaying EQ 
parameters is derived from the Euphonix flagship console, System 5. 

• Bands are mapped from Hi to Low starting with knob cell 1. This means Low bands are at the bottom and High Bands are at 
the top of the channel strip.

• For EQ plug-ins with more than four bands, the PAGE buttons allow for scrolling to additional bands.

Example, for 7 band EQ:

• Page 1 shows LF, LMF, HMF and HF.

• Page 2 shows HPF, LPF and MF.

• LPF and HPF filter slope is toggled by pressing SEL on FREQ knob.

• LPF and HPF filter type is toggled by pressing ON button on FREQ knob.

AUX (send)

The AUX (send) knobset displays SND level. This knobset provides access to Sends A-E in Pro Tools for all channels.

• Pressing SEL toggles through SND A-E.

• ON button toggles Pre/Post.

• Currently No Assign Mode implemented. This can only be accessed via Soft Keys.

PAN (Default Knobset)

The PAN knobset shows the channel strip panner. PAN knobset defaults to NORMAL mode. 

MIX

The MIX knobset displays the currently assigned outputs. 

To assign outputs:

• Turn knob until desired output is displayed.

• Press blinking ON button to assign.

Mirrored, All and/or Cascade Outputs

• To assign multiple outputs from the same channel, hold Control (Mac) when you assign.

• To assign output on all channels, hold Option (Mac) and assign.

• To assign output on all selected channels, hold Option+Shift (Mac) and assign

• To cascade output assignments, add Command (Mac) modifier to any above.

GRP (Group)

The GRP knob Set may seem basic at first glance. The GRP knobset displays the parameters of selected plug-ins. The knobs are 
mapped in the same way as the HUI DSP Edit/Assign section, including a scroll knob. These are mapped to knob cells 1-5 as op-
posed to INSERT knobset, which maps the controls on 3-8 for easy reach on the 408T modules. 

The GRP knob Set also displays the PAN, INPUT, MIX and AUX control on knob cell eight.

The top level of the GRP knobset displays the plug-ins on selected channel. To edit a plug-in, press the corresponding knob-top.
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What makes the GRP knobset special? It allows the operator to edit parameters of any plug-in in the entire session regardless of 
channel or HUI bank. Any plug-in opened from the Pro Tools GUI will be displayed in the GRP knobset. This includes plug-ins 
that are not on any HUI bank.

Similar functionality is possible using the INSERT knob Set. 

The BACK Button

As mentioned above, to access the Knob Set selections on the MC Pro Soft Knobs you must press the BACK button. This is because 
these units are already inside a default knobset (PAN). The BACK button essentially backs out of that knobset. It is possible to ex-
perience the same behavior on the S5MC 408T channel strips. 

Pressing the BACK button on the S5MC 408T channels strips will display the 8 knobsets on the knob cells. If you are at the top 
level of a knobset, like PAN or AUX, pressing the BACK button once can accomplish this. If you have navigated deeper into a knob-
set you may need to press the BACK button several times.

The BACK button on the S5MC 408T channel strips is accessed by pressing the two top-most buttons together.

Multiple Modules and Knobsets

When working with DAW systems that make full use of EUCON adapters it is possible to edit different knobsets across multiple 
channels at the same time. Each unit or channel strip can be used to access a different channel and a different knobset. With the 
use of layouts, it is even possible to access several different knobsets of the same channel by mapping it to several adjacent surface 
channels.

In HUI mode this is not possible however.

The DSP Edit / Assign section of the HUI controller can only access data from a single channel at a time. This limitation is also 
passed onto the EUCON surface when communicating via HUI protocol.

This means that the MC Pro Soft-Knob section will mirror the eight knob cells for any attentioned channel from attached 408T 
modules. Careful attention should be paid to always know what channel is currently attentioned.

Selecting Tracks

S5MC CM408T modules:

Simply press the Chan Select button. It is possible to have Chan Select and Attention linked (in MC preferences). It is important 
to note that you can select multiple tracks, however, only a single channel is attentioned. The last selected track will be the at-
tentioned track in this case.

It is recommended that you link Chan Select and Attention at first. More advanced operators will find it useful to keep these un-
linked. This allows for editing parameters of tracks without affecting the channels select status. Additionally, keeping these un-
linked allows the operator to select tracks without loosing the editing functionality of the currently attentioned channel.

MC Pro Standalone:

Using the touch-screen, press the SEL button and select track cells. Remember that the Pro series allows for separate Attention and 
Select functions. 
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Selecting Multiple Tracks:

There are several ways to select multiple tracks in a Pro Tools session:

• From surface channels, press and hold one Chan Select button while you select all additional channels. This method allows 
for selecting non-adjacent channels. Track selection is reset if you cross over HUI banks; it only works for tracks contained 
in the same HUI bank.

• Select the first channel from the surface or touch-screen. Hold SHIFT on the keyboard, and select the last channel you wish 
to select. This will select a “range” of adjacent channels. This method allows the range to span across all channels.

• You can select multiple non-adjacent tracks from the surface strips by holding down the Command (Windows) key while 
you select. This also works when using the touch-screen for channel selection.

Automation

Automation modes in Pro Tools can be accessed on a per-channel basis directly from any EUCON control surface.

To cycle though all the Automation modes in Pro Tools:

• Read / Write Modes: “Y” button

• Trim Mode On/Off: “N” button 

The surface channel strips use LEDs to display the current Automation status:

Channel Strip LED indication of Automation status

Status Description

Off No LED

Read Green blinking

All Write modes Red blinking

Trim mode Blinking is offset from other 
modes (inverted)
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Wheel Edit Modes

There are several region editing tasks that can be done using the wheel:

• Trim Selection Head

• Trim Selection Tail

• Trim Region Head

• Trim Region Tail

• Move Region

• Slip Audio within Region

The resolution of these controls are based on the Nudge Value set in your Pro Tools session. Nudge Value Increment /Decrement 
keys come pre-programmed on the same page as the Wheel Edit modes in the default Pro Tools app-sets. 

Some time should be spent getting accustomed to these modes and nudge value setting in order to achieve the desired results.

The Wheel Edit modes can be assigned to any Soft-Key. The EUCON commands for these are located in the “Left Edit Section” 
when programming Soft-Keys.

When changing Automation modes, all standard Pro Tools modifiers are still applicable. This makes changing multiple 
channels at one time much quicker.
MC Pro users with the High-Resolution Jog Wheel will achieve best feel and performance with the Jog Wheel Speed set 
between 1–5.



MCS Panner

The JLCooper MCS Panner is supported with the Joystick MC. You must first download and install the 
SurroundPanner_31327.dmg from the Avid website to configure the Surround Panner to use with Pro Tools and the Joystick MC.
To configure the Surround Panner:

1  Launch Pro Tools. 

2  Choose Peripherals > MIDI Controllers.

3  Assuming you have four HUIs configured, re-assign controller #4 to SurroundPnr in the Type field.

4  Set Receive From and Send To to the appropriate EUCON port, as defined in EuPrefs Pane. If you have a previous HUI assign-
ment, first select None, then re-assign to a EuMIDI port.

5  Click OK.

6  Press Soft Key Bank 6 on the MC and you will see the controls for the Surround Panner assigned in the Pro Tools Appset (pre-in-
stalled with the MC from the factory).

7  You must use the JL Cooper Surround Panner Previous/Next and Up/Down functions, which are assigned to Soft Keys, to move 
the Surround Panner from track to track and from Channel Pan to Aux Pan, respectively.

8  If Soft Key Bank 6 has no Surround Panner assignments, you may assign them from the EUCON/HUI Processor by adding a 
EUCON command in Soft Key Setup and selecting Prev/Next, Up/Down and other MCSPanner functions. Please refer to the 
JL Cooper MCS Panner user guide (www.jlcooper.com) for complete instructions.

Pro Tools Surround Panner selection
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Mackie Control Universal
Mackie Control Universal is a widely used MIDI-based protocol that controls application parameters and supports metering in 
many DAW applications. The extent to which Mackie Control can be used depends on the specific application’s implementation. 
The MC uses its own MIDI-over-Ethernet driver (incorporated into the EUCON software) to easily control these programs without 
MIDI cables.

You must have already done all of the following:

• Added the application(s) to control to the EUCON Preferences pane. 

• Set their Protocol to Mackie Control

• Configured the MIDI ports they will use.

This is required before each application can be configured.

Final Cut Pro 6 and Soundtrack Pro 2 (Final Cut Studio 2)

Configuring Final Cut Pro and Soundtrack Pro to operate with the MC is very simple. Since both are Apple applications, their in-
terfaces are similar and instructions may be combined.

Before proceeding, Final Cut Pro and Soundtrack Pro must already:

• Have been added as non-EUCON applications in the Euphonix Preferences Pane;

• Set to use Mackie Control,

• Have MIDI ports set.

To finish the configuration:

1  In Final Cut Pro, choose Tools > Control Surfaces.

2  In Soundtrack Pro, choose Soundtrack Pro > Preferences.
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3  Click the Control Surfaces tab at the top. Now both programs can follow the same instructions. 

Add Control Surface dialog (Soundtrack Pro)



4  Click the + button.
5  Select Mackie Control from the Control Surface Type pop-up menu.

6  For the Input and Output Connection pop-up menus, select the MIDI send and receive ports. These will be the same port, so 
if Soundtrack Pro uses ports 5–8, the first controller sends and receives on port 5.

7  Click OK to close the Add Control Surfaces dialog.

8  Repeat the process to add up to four controllers.

Add Control Surface dialog
9  When finished adding controllers, click the OK button to close the dialog in Final Cut Pro. In Soundtrack, click the Close button 
at the top left to close the Preferences.

10  Restart the application or computer if initial communication is not achieved. The MC connects and updates with new track 
information.

Digital Performer 5

Configuring Digital Performer 5 to operate with the MC using Mackie Control

1  Open Audio/MIDI setup. 

2  Create up to 4 Mackie Controls and cable to the Euphonix MIDI ports as defined in EuPrefsPane.

For System 5 MC owners, remember the MC mirrors one CM408T module, so up to four CM408T modules can be used with one MC.
Digital Performer Midi Devices
3  In Digital Performer, do the following: 
• Go to Setup > Control Surfaces.

• Add one Mackie Control and select the first Mackie Control from the MIDI menu.

• Add any additional units as Expander (XT) modules.
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Sony Vegas 7

Sony Vegas 7.0 supports the use of Mackie Control Universal for up to eight faders at once. Most Mackie Control functions can 
be custom mapped within Sony Vegas. See Sony Vegas documentation for full details. Basic configuration instructions are as fol-
lows: 

1  Add Sony Vegas to Euphonic Control panel.

2  Open Sony Vegas 7 and go to Options > Preferences > MIDI.

Digital Performer Control Surface
3  Enable the four Euphonix MIDI ports specified in the Euphonix Preference Pane.

4  Go to Options > Preferences > External Control & Automation.

5  Select Mackie Control from the Available Devices pop-up menu and click Add. 

6  Double click on the newly created control device to configure.

MIDI Tab



7  Configure Mackie Control Device by doing the following:

• Select Emulated Mackie Control Device from the Device Type pop-up menu.

• Select the specified Euphonix EuMIDI Input and Outputs.

• Click OK.

External Control & Automation Tab
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Appendix A: Studio Monitor Pro 2

What is SMP2?
Studio Monitor Pro 2 (SMP) is a versatile and powerful virtual representation of a multi-channel master-section of an audio 
console.   SMP runs on your workstation or dedicated SMP computer, and provides full control of routing between applications, 
external ASIO hardware inputs and outputs. SMP also provides extensive communications control for Talkback, Studio Monitor 
and Record feeds. 

SMP is equipped with a complete user definable multi-channel monitor matrix for professional surround sound monitoring with 
up to 7.1 speaker outputs, each with level, dim and mute features. 
Studio Monitor Pro 2
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Overview of Signal Flow and Concepts
Hardware I/P’s and/or Application O/P’s are patched to SMP internal busses called SMP I/P’s. These internal busses are combined 
in logical groupings called Sources. User defined Sources are then assigned to Control Room, Monitor and/or Record feeds which 
are patched to either hardware speaker O/P’s or other Application I/P’s. Additionally, SMP allows the user to Directly route Hard-
ware I/P’s to Application I/P’s (and vice versa) bypassing any additional internal SMP routing.

SMP also allows the user to define Hardware I/P’s as any of 4 Talkback Sources each of which can be routed to any of the Main 
Control Room, Monitor and/or Record destinations. Pre-fader Metering O/P’s can be defined to feed any available Hardware O/P 
and a Main Control Room Monitor Insert Send & Return (pre-fader) can be created using either Hardware or Application I/O’s. 

While the Main Control Room, Monitor and Record feeds have individual level control as well as dim and cut features, their 
respective SMP O/P destinations also have individual level and cut control, including alternate speaker O/P destinations for the 
Main Control Room.

Signal Flow Diagram
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iLok Security Key

SMP2 requires proper authorization from a supplied iLok USB device to operate once installed. The application will allow the user 
to operate in Demo mode for up to 10 startups before the iLok is required.

ASIO Selector Pro

When SMP2 installation has completed, the ASIO selector will prompt to select an ASIO device driver. Select the driver from the 
pop-up menu and click OK. You can access the ASIO Selector Pro at anytime from Start > Programs > EuCon. 

Signal Flow 



Configuration
Enable Hardware Ports

This allows for explicitly enabling or disabling of each available I/O port from the selected ASIO hardware.

This limits the ASIO stream’s input and outputs being passed in or out of SMP, thus minimizing PCI bus traffic to only those ports 
necessary for the current setup.

Once enabled, the ports become available for source & destination patching in the other tabs.

CPU Usage

This meter shows current SMP2 CPU usage (typically 1–2%).

Hardware Settings: Control Panel

This button opens the Control Panel for the selected ASIO hardware.

Save / Load Settings

Allows the user to Save and Load SMP2 configurations. All settings, including enabled/disabled HW ports, sources, I/O patching 
and levels are saved and/or recalled using this feature.

Sample Rate Selector

Allows the ASIO hardware sample rate to be set directly from SMP2. The selected sample rate is also passed to connected software 
applications.

Dim Level / Fixed Level

DIM

This sets the amount of attenuation (in dB) applied to any program material when the DIM switch is enabled. (DIM level is a 
global setting.)

SMP Configuration tab
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The DIM level is adjustable from the MC Control Room surface section. 

To adjust DIM level: 

1  Press the DIM button

2  Turn the CR knob to adjust the amount of attenuation.

Fixed Level

This slider sets the fixed output level, enabled from the Main tab for the Main Control Room output. This is a useful setting for 
systems requiring specific monitoring levels such as SDDS mixing environments.

I/O Patching
The routing of signals between hardware, software applications and SMP I/O (input/output) busses is handled in three separate 
tabs: SME O/P Patch, Application I/P Patch, and Hardware I/P Patch. Additionally these same tabs allow Monitor Insert Send and 
Return patches to be configured.

SMP O/P Patching
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This tab is used to setup your O/P (output) patching for speaker, monitor and record paths as well as Insert Sends.

The left side displays all available SMP O/P sources. This includes Main Control Room (7.1), Alt 1, Alt 2, Monitor A, Monitor B, 
Record A (7.1) and Record B feeds. Monitor Insert Sends are also routed from this tab.

SMP O/P sources can be routed to any available Hardware O/P and/or Application I/P (EuIn 1-98) destination. To route a source, 
simply click on the patch cell and select from the pop-up menu of available destinations.

SMP O/P Patch tab



Application O/P Patch

This tab is used to patch the outputs of your software application to SMP I/P busses or directly to Hardware O/P’s. 
SMP allows up to 128 source O/P’s (EuOut) from any software application. These are displayed on the left. Two separate SMP I/P 
patch configurations are permitted: A/B (selectable from the Main tab). Additionally, the column labeled Hardware O/P allows for 
Direct O/P patching.

To route a source, simply click on the patch cell and select from the pop-up menu of available destinations.

Monitor Insert Return paths can be assigned from here and will show up as an available destination.

Application O/P Patch tab
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Hardware I/P Patch

The Hardware I/P Patching tab is used to configure the destination of any enabled Hardware I/P’s to SMP I/P busses or directly to 
the Application I/P’s (EuIn).
MC Pro User Guide04
The left-most column displays all Hardware I/P sources enabled in the Configuration tab. 

SMP2 allows for two separate SMP I/P patch configurations: A/B (selectable from the Main tab). Additionally, the column labeled 
Application I/P allows for Direct I/P patching (EuIn 1-98).

To route a source, simply click on the patch cell and select from the pop-up menu of available destinations.

Monitor Insert Return paths can be assigned from here and will show up as an available destination.

Hardware I/P Patch tab



Source Setup
The Sources Setup tab allows for the creation of logical groupings of SMP I/P’s called Sources. It is recommended that the created 
Sources correspond to the various Application O/P stems and/or External I/P sources as applicable to each individual system 
configuration.

Using the Source Availability Selector, each Source can be explicitly enabled or disabled from each SMP O/P feed.
New Source

Name 

Type in the name of the Source to be created. 

Start Channel 

This pop-up menu is used to assign the first SMP I/P bus used in the Source.

Format 

This allocates the number of consecutive SMP I/P channels and determines the SMP O/P routing as specified in the User Formats 
settings. Standard default formats such as Mono, Stereo, 5.1, 6.1, and 7.1 are available.

Source Information

After a Source is created, it will appear in this section. To delete a Source: select the Source to be deleted, and press the 
Delete button.

Source Availability Selector

This allows for explicit enabling or disabling of any created Source to be routed to the Main SMP O/P feeds.

Enabled sources under each SMP O/P feed will be available in the Main tab as a Source Selection.

Sources Setup tab
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Talkback
SMP2 allows for four separate Talkbacks to be created, each with their own destinations and behavioral actions that determine 
the affect on each of the Main SMP O/P feeds when enabled.

Currently, only Talkback 1 can be engaged from the MC Control Room surface.
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Select

This chooses which of the 4 Talkbacks is being edited.

Level

This set the Level of the currently selected Talkback.

Change Name

This allows the name of the currently selected Talkback to be changed.

Source

This allows for any of the 4 Talkback Sources to be assigned as the source I/P of the currently selected Talkback.

Destination

Each Talkback source can be assigned to any of the Main SMP O/P feeds.

Action

When engaged, each Talkback can carry out various actions (Dim or Cut) on each of the Main SMP I/O feeds.
Select the action for each of the Main SMP O/P feeds using the pop-up selections for the currently selected Talkback source.

Talkback tab
Talkback Source 
Each pop-up menu allows any available Hardware I/P to be patched as a Talkback I/P source.



Speakers
The Speakers tab allows attenuating and muting monitor section output levels. Drag the faders to adjust the level indicated in the 
field above the fader. Click the Cut button to mute the output. 

Level and Cut controls are provided for each speaker for individual O/P calibration.

Each monitoring section has its own controls:

Control Room Main, Alt 1, Alt 2.

Recording Record 1, Record 2.

Monitors A and B.

Speakers
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Main
The Main tab provides access to all the necessary features and parameters used for general operation. 

The parameters of the Main tab may also be accessed using the Control Room section of the MC surface and the MC touchscreen.
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Overview of Main 

The Main tab controls the following:

Source Selection  For Control Room, Monitor and Record feeds (SMP O/P’s).

Level, Dim and Cut  For each feed.

Format

• Control Room and Record A feeds allow up to 7.1 multi-channel O/P formats to be selected.

• Monitor A, Monitor B and Record B are either Mono or Stereo.

• Folddown:

• Selecting an O/P format smaller than the Source I/P format will down-mix the channels based on the settings specified in 
the Folddown Matrix.

• Sum, Inter-cancel and Auto Scale for each feed.

• Sum: this allows multiple Sources to be selected simultaneously.

• Inter-cancel: this allows for only one source selection to be made. Any previously selected sources will be deselected.

• Auto Scale: Used in conjunction with Sum, this keeps the combined output level scaled down to compensate for the 
increased level of summed signals.

Main tab



Parameters

Control Room

The Control Room O/P feed provides additional features:

Speaker Selection 
• Main: up to 7.1 multi-channel O/P

• Alt 1 and Alt 2: provided for additional stereo speaker O/P’s.

Fixed 

This sets the level of the CR to the specified fixed level set in the Configuration tab.

Reverse

Reverses polarity (180º phase) of the Left O/P signal.

Monitor Insert Send / Return 

(Control Room Feed Only)

The Monitor Insert Send and Return switches turn on/off the Insert signal paths.

Insert Send Patching is assigned in the SMP O/P section.

Insert Return Patching is assigned in either the Hardware I/P or Application O/P sections.

• Return Format: The Insert Return Format selector allows for the User Format channel assignments to be applied to the in-
coming Insert signal.

Comms: Talkback

Used to engage any of the four Talkbacks. Talkback 1 is accessible from the MC surface Control Room section.

A/B Matrix Switching

SMP2 allows for two separate SMP I/P patch configurations: A/B. The A-B Matrix buttons are used to select either SMP I/P A or B 
configuration.
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User Format
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The User Format tab allows for custom bus-to-channel allocation to be defined for multi-channel monitoring. These mappings 
are used for defining the format of Sources in the Source Setup section, and to define the input format of the Monitor Insert Re-
turn. User Formats may have a channel width up to 8 channels wide (7.1).

Select

 Default pre-defined formats are: Mono, Stereo, LRCS, 5.1, 6.1, & 7.1

Four undefined User Formats are provided (User 1–4). To change a predefined or user format, select from the pop-up menu and 
make desired changes. 

Channels (in Selected Format)

This pop-up menu defines the number of channels used for the selected Format.

Change Name

All User defined formats may be renamed at anytime. User Format names appear in the Source Setup tab as well as the Monitor 
Insert Return Format settings. To change the name of the currently selected format, type the desired name in the field and press 
Apply.

Channel Selection

The Channel Selection settings are used to define the Formats bus-to-channel allocations.

Ch 1-8 refer to the SMP I/P’s (bus) of selected source. The pop-up selections refer to the channel destination (SMP O/P) that the 
relative SMP I/P channel will be re-directed to.

User Format



Folddown/Metering
Metering

The Metering sections allows for dedicated pre-fader signals to be routed to any available Hardware O/P’s.

To patch an O/P destination: select the desired Hardware O/P in the desired patch cell.

The metering O/P’s follow the Source selection of their respective SMP O/P feeds in the Main tab.

Folddown

This section allows for custom Folddown (down-mixing) rules to be defined.

The Folddown rules are applied by SMP2 at anytime that the I/P source format is wider than the currently selected monitor O/P 
format.

Format In / Format Out

The selected I/P Format will be down-mixed to the selected O/P Format based on the settings defined in the Folddown Matrix.

Folddown Matrix

The X-Axis (horizontal) denotes the available O/P channels in the selected O/P Format.

The Y-Axis (vertical) denotes the incoming channels of the selected I/P Format.

Folddown values (in dB) can be entered in white cells to define the rules for the currently selected Folddown Matrix. To save the 
current set of folddown rules, press the Submit button.

Folddown / Metering Tab
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Fine Tune Slider Control

The following keys and modifiers can be used to get fine tune control of sliders (faders) in Studio Monitor Pro 2:

• HOME key: jump to 0 dB position

• END key: jump to OFF position

• PAGE UP key: +12 dB

• PAGE DOWN key: -12 dB

• Press and hold SHIFT key during slider mouse movement: 0.1 dB steps.

For Vertical Sliders

• ARROW LEFT key: +3 dB

• ARROW RIGHT key: –3 dB

• ARROW UP key: +0.1 dB

• ARROW DOWN key: –0.1 dB

For Horizontal Sliders

• ARROW LEFT key: +0.1 dB

• ARROW RIGHT key: –0.1 dB

• ARROW UP key: +3dB

• ARROW DOWN key: –3 dB

The following pages make use of the new sliders:

•  Main

•  Talkback

•  Configuration

•  Speakers
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Appendix B: Compliance Information
Environmental Compliance

Disposal of Waste Equipment by Users in the 
European Union

This symbol on the product or its packaging indicates that this product must not 
be disposed of with other waste. Instead, it is your responsibility to dispose of 
your waste equipment by handing it over to a designated collection point for the 
recycling of waste electrical and electronic equipment. The separate collection 
and recycling of your waste equipment at the time of disposal will help conserve 
natural resources and ensure that it is recycled in a manner that protects human 
health and the environment. For more information about where you can drop off 
your waste equipment for recycling, please contact your local city recycling office 
or the dealer from whom you purchased the product.
Proposition 65 Warning

Perchlorate Notice

This product may contain a lithium coin battery. The State of California requires 
the following disclosure statement: “Perchlorate Material – special handling may 
apply, See www.dtsc.ca.gov/hazardouswaste/perchlorate.”

Recycling Notice

This product contains chemicals, including lead, known to 
the State of California to cause cancer and birth defects or 
other reproductive harm. Wash hands after handling.
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EMC (Electromagnetic Compliance)
Avid declares that this product complies with the following standards regulating 
emissions and immunity:
• FCC Part 15 Class A
• EN55103-1 E4
• EN55103-2 E4
• AS/NZS CISPR 22 Class A
• CISPR 22 Class A

FCC Compliance for United States

Communication Statement
Note: This equipment has been tested and found to comply 
with the limits for a Class A digital device, pursuant to part 
15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference when the 
equipment is operated in a commercial environment. This 
equipment generates, uses, and can radiate radio frequency 
energy and, if not installed and used in accordance with the 
instruction manual, may cause harmful interference to radio 
communications. Operation of this equipment in a 
residential area is likely to cause harmful interference in 
which case the user will be required to correct the 
interference at his own expense.

Any modifications to the unit, unless expressly approved by 
Avid, could void the user's authority to operate the 
equipment.
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Australian Compliance

Canadian Compliance

This Class A digital apparatus meets all requirements of the Canadian 
Interference-Causing Equipment Regulations. 

Cet appareil numérique de la classe A respecte toutes les exigences du 
Règlement sur le material brouilleur du Canada.

CE Compliance

(EMC and Safety)

Avid is authorized to apply the CE (Conformité Europénne) mark on this compliant 
equipment thereby declaring conformity to EMC Directive 2004/108/EC and Low 
Voltage Directive 2006/95/EC.

N1709



Safety Compliance

Safety Statement

This equipment has been tested to comply with USA and Canadian safety 
certification in accordance with the specifications of UL Standards: 
UL60950-1:2007, 2nd Ed and CAN/CSA C22.2 No. 60950-1-07, 2nd Ed.  
Avid Technology Inc., has been authorized to apply the appropriate NRTL mark on 
its compliant equipment.

Warning

Important Safety Instructions

1) Read these instructions.

2) Keep these instructions.

3) Heed all warnings.

4) Follow all instructions.

5) Do not use this equipment near water.

6) Clean only with dry cloth.

7) Do not block any ventilation openings. Install in accordance with the 
manufacturer’s instructions.

8) Do not install near any heat sources such as radiators, heat registers, stoves, 
or other equipment (including amplifiers) that produce heat.

9) Do not defeat the safety purpose of the polarized or grounding-type plug. A 
polarized plug has two blades with one wider than the other. A grounding type 
plug has two blades and a third grounding prong. The wide blade or the third 
prong are provided for your safety. If the provided plug does not fit into your 
outlet, consult an electrician for replacement of the obsolete outlet.

10) Protect power cords from being walked on or pinched particularly at plugs, 
convenience receptacles, and the point where they exit from the equipment.

11) Only use attachments/accessories specified by the manufacturer.

12) For products that are not rack-mountable: Use only with a cart, stand, tripod, 
bracket, or table specified by the manufacturer, or sold with the equipment. 
When a cart is used, use caution when moving the cart/equipment combination 
to avoid injury from tip-over.
13) Unplug this equipment during lightning storms or when unused for long 
periods of time. 

14) Refer all servicing to qualified service personnel. Servicing is required when 
the equipment has been damaged in any way, such as power-supply cord or plug 
is damaged, liquid has been spilled or objects have fallen into the equipment, 
the equipment has been exposed to rain or moisture, does not operate normally, 
or has been dropped.

15) For products that are a Mains powered device: 
The equipment shall not be exposed to dripping or splashing and no objects filled 
with liquids (such as vases) shall be placed on the equipment. 

Warning! To reduce the risk of fire or electric shock, do not expose this 
equipment to rain or moisture. 

16) For products containing a lithium battery: 
CAUTION! Danger of explosion if battery is incorrectly replaced. Replace only 
with the same or equivalent type. 

17) For products with a power switch: 
It should remain accessible after installation.

18) The equipment shall be used at a maximum ambient temperature of 40° C.

19) This unit is provided with a power supply cord set suitable for 120V AC input 
only (for U.S.A.and Canada). For other than U.S.A. and Canada, a qualified 
person must provide for use with this unit, an appropriate, approved power 
supply cord set which is in compliance with the end use country requirements 
and has a minimum cross-sectional area of 1.0mm2.

20) For products with more than one power cord:

CAUTION: This unit has more than one power supply cord. Disconnect two power 
supply cords before servicing to avoid electrical shock.

ATTENTION: Cet appareil comporte plus d’un cordon d’alimentation. Afin de 
prévenir les chocs électriques, débrancher les deux cordons d’alimentation 
avant de faire le dépannage.

21) For products with an operator-accessible fuse:

CAUTION: For continued protection against risk of fire, replace only with same 
type and rating of fuse.

ATTENTION: Pour ne pas compromettre la protection contre les risques 

d’incendie, remplacer par un fusible de même type et de même caractéristiques 

nominales.
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Avid
2001 Junipero Serra Boulevard 
Daly City, CA 94014-3886 USA
Technical Support (USA)
Visit the Online Support Center at 
www.avid.com/support
Product Information
For company and product information, 
visit us on the web at www.avid.com
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